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About InteGrade Pro
InteGrade® Pro student information software helps teachers track student 
performance over the duration of a course. It can record a virtually 
unlimited number of tasks and students per gradebook. You can organize 
tasks and put them into categories such as homework, quiz, or lab 
exercises. You can reward good performance with bonus scores and 
correct poor performance by graphically showing a student where they 
stand or adjusting scores.

The platform compatibility of InteGrade® Pro student information software 
means you can move your files from Microsoft Windows to a Macintosh 
computer. Switching platforms requires no conversion and preserves 
nearly all features.

At the end of a term, the system can transmit final grades back to the main 
office system to print report cards.

What’s New about InteGrade Pro 7.0
In addition to an improved user interface, InteGrade Pro student 
information software version 7.0 provides seven major new features:

l Spell checking

l Email reporting
Copyright © 2000 National Computer Systems, Inc. What’s New about InteGrade Pro 7.0  1
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elp
l Multiple student contacts

l Class and Student Attendance reports

l Seating Chart report

l Integration with NCS scanners

l Auto-Recovery

This version is a major update to the system and is not available as a 
downloadable update. Instead, it is being mailed to all customers with 
active support agreements.

Note to administrators: InteGrade Pro student information software 
version 7.0 uses a different file format than previous versions. When a 
gradebook is saved with this version, it will be converted into the newer 
format. Users will be unable to open the gradebook with previous versions 
of this product.

For a list of all enhancements to InteGrade Pro student information 
software, see the Readme files on your installation CD. You can read 
these files after installing the product.

All instructions apply to all versions of this product, unless noted 
otherwise.

The Toolbar Icons

This version has a toolbar as a shortcut to frequently used commands.

If your computer has Internet access, you can access the InteGrade Pro 
web site and the NCS Educational Structures custom Internet curriculum 
web site directly from the toolbar.

Open 
Gradebook Print 

Save 
Gradebook Copy

New 
Tasks

Paste

Find
Again

Cut
Edit 
Spreadsheets

Edit 
Tasks Task Comparison Graph

Student Performance Graph

InteGrade Pro web site

Task Correlation Graph

NCS Educational Structures 

Find

Edit 
Students

Next 
Spelling
Error

H
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Some Words You Should Know

Scores and Grades

Scores are the input values—the marks that students receive on individual 
tasks such as tests or homework assignments.

Grades are the output values—the result of calculations that use scores. 
Calculations are performed according to the task and task type weighting 
schemes that you create.

Class

A class is a single course taught in a single period as defined by your 
office administration computer system. It consists of spreadsheets, 
students, tasks, and a task type set.

Tasks, Types, and Sets

Tasks are work items that you assign to students like a quiz on King Lear 
or a set of math problems. 

Task types are categories such as Quiz, Homework, or Lab exercises. 
Task type sets group task types together. 

For example, suppose you teach Biology and English. Your Biology class 
has a Lab, but your English class does not. In that case you would use four 
task types: Homework, Quiz, Lab, and Exam. You would group them into 
two task type sets: Sciences and Humanities. Sciences includes the Lab 
task type, while Humanities does not.

Task Type Set

Othello Quiz Humanities

Alice in Wonderland Homework Humanities

English 201 Midterm Exam Humanities

Cell Division Quiz Sciences

Individual Study Homework Sciences

Plant Propagation Lab Sciences

Biology Exam Exam Sciences
Copyright © 2000 National Computer Systems, Inc. Some Words You Should Know  3
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You can define as many task type sets as you like, then assign one set to 
each class

Comments and Notes

Comments are the short phrases used on report cards to describe the 
progress of a student.The End Term spreadsheet can submit comments 
back to the office system, along with the final grades. The number of 
comments per student to export depends on the office system.

Notes are anecdotal text that you enter for classes, tasks, students, and 
individual scores.

Spreadsheet

A spreadsheet is a collection of tasks and scores for a single class. It 
records student scores in a grid structure, hence the name spreadsheet. 
Each class can have more than one spreadsheet, for example for different 
reporting periods. 

There are four types of spreadsheets used in InteGrade® Pro student 
information software.

Numeric 

This is the traditional gradebook where a teacher enters scores and 
calculates grades. The student names are on the left side, with scores in 
the middle and the calculated grades on the right side.

Scores can be numeric or text labels represented by special scores.
4  Some Words You Should Know Copyright © 2000 National Computer Systems, Inc.
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Each Numeric spreadsheet can have a different letter grade table. This 
enables you to use different grading rules for sets of tasks or for different 
terms.

When you create a Numeric spreadsheet, you have two choices, either a 
Weighted or a Total Points type. 

The Weighted type spreadsheet uses task types to weight scores when 
calculating the final spreadsheet grade. Weighted type numeric 
spreadsheets display a Percent (%) column and a Letter Grade column. 
You can customize these columns to display one of ten other statistical 
transformations of the final spreadsheet grade.

The Total Points spreadsheet calculates the spreadsheet grades based on 
points received versus points possible. It does not use task types to weight 
scores when calculating the final spreadsheet grade. The Total Points 
numeric spreadsheet displays a Points Received column (showing the 
sum of all points scored by each student for all tasks on the spreadsheet) 
and a Letter Grade column. You can customize the last two columns to 
display a percentage or one of 14 other statistical transformations of the 
final spreadsheet grade.

Skill 

The Skill spreadsheet looks like a numeric spreadsheet, except that it 
does not calculate grades. It shows whether or not students have acquired 
certain skills

Use skill spreadsheets to track student proficiency in specific content 
areas. Scores are not associated with a numeric value and spreadsheet 
grades are not calculated.
Copyright © 2000 National Computer Systems, Inc. Some Words You Should Know  5
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Attendance 

An Attendance spreadsheet records student attendance for the class. 
Each spreadsheet records attendance day by day, once per day. You can 
create multiple attendance spreadsheets, if necessary, within a class.

EndTerm 

InteGrade Pro student information software creates an EndTerm 
spreadsheet only when you import your class roster file from an 
administrative system. It stores the data that you send to the main office at 
the end of a reporting period.

The ETS appears as a simplified version of the Numeric spreadsheet. The 
student demographic column displays the same information. Columns 
record comments, attendance, and final grades (these are the columns 
labeled 1, 2, 3, and so on) replace task score columns. 

The EndTerm spreadsheet reflects any sorting or reordering in the 
Numeric spreadsheet and vice versa. The actual appearance of your 
EndTerm Spreadsheet can vary, depending on the administration system 
and on the mark types your system administrator has set up for you to 
complete.
6  Some Words You Should Know Copyright © 2000 National Computer Systems, Inc.
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The Comments column contains the numbers for the comments printed on 
the report cards. Most school administrative systems use preset 
comments identified by numbers. You can use a comments.txt file to assist 
you with entering the comments. 

The Attendance column contains the number of absences for each student 
for the reporting period. Use the Replace Tasks command to total the 
number of absences, accessed by clicking on a column title. You can also 
use the Copy Tasks command from the Tasks menu.

The Final grades column contains the final grades to be printed on the 
report cards. Each numbered column represents a specific mark type 
recorded for the reporting period. You should have received instructions 
regarding the information to enter for each column. It is very important to 
enter the grades into the correct column.

Gradebook

A gradebook keeps track of all the students and classes you teach. 
InteGrade Pro student information software uses one gradebook per 
teacher, regardless of the number of students or classes taught. If you 
teach at more than one school, you must have a separate gradebook for 
each school. A gradebook contains students, classes, special scores, and 
letter grade tables.

You can have only one gradebook open at a time.

Class Viewer

A class viewer displays one spreadsheet for one class. When you open a 
gradebook file, a viewer opens automatically.
Copyright © 2000 National Computer Systems, Inc. Some Words You Should Know  7
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A class viewer provides a way to switch between classes and between 
spreadsheets. You can open more than one viewer. For example, each 
viewer could display a different class. The only limit is your computer’s 
memory.

A teacher who prefers a clean desktop would open one viewer and use the 
drop-down lists to switch between classes and between spreadsheets 
within a class. A teacher who prefers to organize data over several 
windows can open multiple viewers and use the organizing commands in 
the View and Window menus to manage the multiple viewers.

The Show drop-down list lets you turn on or off the Tasks, Students, and 
Notes areas. For example, when you are creating your task list at the 
beginning of the year, you might only want to see tasks. If you are entering 
scores, you might only want to see the students. The drop-down list 
changes depending on the spreadsheet being viewed.

1. Select a class from the drop-down list.

2. Select any spreadsheet associated with that class.

3. Select what you want to see in this spreadsheet.

Working In A Viewer

4. Select Task or Type.

Auxiliary columns that you can choose
to display or not, as well as choose what
gets displayed in them.
8  Some Words You Should Know Copyright © 2000 National Computer Systems, Inc.

http://k12.ncs.com/


Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
The View drop-down list -- for a Numeric spreadsheet only -- lets you 
toggle between task and task type view. Task view shows the individual 
tasks. Type view rolls everything into the respective task types (for 
example, homework or quizzes). This view is ideal for you to quickly see 
how your class is faring on various tasks. This choice is available only in 
Numeric spreadsheets. For any other spreadsheet, there is only one 
choice.

The column headings in the task and student areas can be customized. 
Auxiliary columns can be turned on or off and their contents can be 
customized. For example, you may choose to see percentage or letter 
grade, or one of a dozen score transformations. See “Customizing 
Spreadsheet Columns” on page 52.

Opening a Viewer

1. From the View menu, select Open Class Viewer. 

2. Select the class you want to view. 

3. Click Open. 
This second viewer might cover your first. Use the Window menu to 
switch from one viewer to another, or to arrange the viewers on screen. 
You may also resize and move each viewer so that both are visible at 
once.

Closing a Viewer

Closing a viewer does not affect data already entered. Closing the last 
viewer closes the gradebook.

1. To close a class viewer, select the viewer you want to close so that it is 
the active window.

2. From the View menu, select Close Class Viewer.
You can also click the Close box in the corner of the window.

Context Menus

Context menus are the shortcut menus that display when you right-click 
(Windows) or Ctrl-click (Macintosh) in certain areas of the viewer.
Copyright © 2000 National Computer Systems, Inc. Some Words You Should Know  9
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For example, if you display the context menu in the task area of a 
spreadsheet, you are presented with two sort options, as well as shortcuts 
to the New Task and the Edit Task menu items.

Context menus are used throughout InteGrade Pro student information 
software. Another example is in the seating chart. If you display the 
context menu on a desk, you are presented with two options to Fill Chart 
or Replace Task, as well as the complete list of attendance codes.

Overview of a School Year
At the start of the year, you create a new gradebook, then import a class 
roster file from your administration database. Although you can create a 
gradebook manually, you must import a data file if you want to export back 
to the office.

Next, you customize the gradebook to suit your teaching methodology by 
setting up the task types and scoring schemes. You may also import tasks. 
This may already be set up if you electronically imported your class data.

For the remainder of the year, you use InteGrade Pro student information 
software to record student scores on tasks, record student attendance, 
and print reports. 

At the end of each reporting period, you can export data to the school’s 
administration computer for grade reporting. 

At the end of the school year, you back up and archive your data.

The following diagram is an overview of how you use InteGrade Pro 
student information software at each stage of the reporting period.
10  Overview of a School Year Copyright © 2000 National Computer Systems, Inc.
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File Naming Conventions

Prefixes of File Names

CL
Files created by the administration system are named CLxxxxxx.GRD. 
The CL prefix designates the file as a Class Roster file and the xxxxxx’s 
represent your teacher code. These files contain information on classes, 
students, and define the End Term spreadsheet.

MK
Files created by InteGrade Pro are named MKxxxxxx.GRD. The MK prefix 
designates the file as a Marks data file and the xxxxxx’s represent your 
teacher code. These files contain information on grades and attendance.

2. Add tasks and scores
and notes throughout the
reporting period, and take
attendance.

School
Administration

System
InteGrade Pro

1. Import class roster file
from school administration
system into InteGrade
Pro.

3. Export your EndTerm
spreadsheet to the school
administration system at
the end of the reporting
period.

Abbasi, Elisa  7  9.5  26  11 11.5
Bregder, Audrey  6  10.5  27  11.5  9
Calder, Cara  8.5  13  31  14.5  11
Castro, Michael  6.5  Sick  26  10
Cortez, Miguel  7  9.5  32  INC  11.5

Abbasi, Elisa  7  9.5  26  11 11.5
Bregder, Audrey  6  10.5  27  11.5  9
Calder, Cara  8.5  13  31  14.5  11
Castro, Michael  6.5  Sick  26  10
Cortez, Miguel  7  9.5  32  INC  11.5

School
Administration

System
Copyright © 2000 National Computer Systems, Inc. File Naming Conventions  11
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AB
Files created by ABACUSxp are named ABxxxxxx.GRD. The AB prefix 
designates the file as an ABACUSxp file and the xxxxxx’s represent your 
teacher code. These files contain task information and can be imported 
into InteGrade Pro to record mastery values on the Skill spreadsheet.

AT
Test files created by ABACUSxp are named ATxxxxxx.GRD. The AT prefix 
designates the file as an ABACUSxp file and the xxxxxx’s represent your 
teacher code. These files contain test information and can be imported into 
InteGrade Pro to record test values on the Skill spreadsheet.

Suffixes of File Names

.GBF
Gradebook file; for example sample.gbf

.GRD
Class roster files, used in import and export (TSS and Osiris use .GC); for 
example cljoanfr.grd

.BAK
Backup file that preserves the second-to-last version of your gradebook

A BAK file is a back-up file that preserves the second-to-last version of 
your gradebook, usually in the InteGrade Pro program file folder of your 
hard disk. The BAK file is titled “name of your gradebook file”.BAK. Until 
you save a gradebook a second time with a new password, the .BAK file 
version of the saved gradebook does not incorporate new or changed 
passwords. 

See the Administrator’s Guide for the complete list of files used in 
importing and exporting to other administration systems.

Working On a Macintosh
The Macintosh operating system is able to handle both Macintosh and 
Windows files, but the Windows operating system can handle only 
Windows files.

As a result, if you are using the system in a mixed environment and plan to 
take files back and forth from a Macintosh to a Windows system, you must 
name your files according to Windows standards. If you always use 
Windows standards for naming your files--even while working on a 
12  Working On a Macintosh Copyright © 2000 National Computer Systems, Inc.
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Macintosh--the Windows operating system will always be able to handle 
files from your Macintosh and you will not have to take any additional 
steps.

Where to Find More Information
If you have a question about InteGrade Pro student information software 
or need more information, use the help system or this manual. If you need 
additional assistance, you can contact Technical Support.

Using the Online Help System

The help system contains the information found in this guide in an easy-to-
access format. There are two ways to use the help system:

l Choose Contents from the Help menu (Windows) or choose InteGrade 
Pro Help from the Help menu (Mac). This opens the contents topic and 
lets you browse the help system or search for specific topics.

l Click the Help button in a dialog box or press <F1> (or the <Help> key 
on the Mac). This displays a help topic about that dialog box with links 
to topics describing all the procedures that can be performed from that 
dialog box. 

Technical Support Services

National Computer Systems (NCS) offers the following services to users 
with active maintenance agreements:

l InteGrade Pro student information software telephone support—(800) 
282-4490. 

l InteGrade Pro student information software and other administration 
systems:

l InteGrade Pro student information software and SASIxp, (800) 472-
7497.

l InteGrade Pro student information software and SASI III, (800) 622-
7647.

l InteGrade Pro student information software and CIMS, (800) 736-4357.

l InteGrade Pro student information software and Osiris or Osiris for 
Elementary Schools, (800) 282-4490.

l InteGrade Pro student information software and The School System or 
Copyright © 2000 National Computer Systems, Inc. Where to Find More Information  13
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The Elementary School System, (800) 282-0355.

l E-mail Support - contact a support representative at our e-mail address, 
support@ncslink.com

l Training—For information about the training services available from 
National Computer Systems, or to schedule training, call (800) 736-
4357.

l Customer Service—For information about other products available from 
National Computer Systems call (800) 736-4357 or e-mail us at 
salesessd@ncslink.com. 

l To submit suggestions for enhancements to the product, e-mail us at 
integrade@ncslink.com. For information and suggestions, you can also 
visit our web page at k12.ncs.com.

l You can also visit www.integrade.com a web site devoted to the use of 
InteGrade Pro student information software. 

When Requesting Technical Support

Be sure you include the following information when requesting technical 
support:

l Your site number.

l The version number and platform of InteGrade Pro student information 
software. For example, InteGrade Pro 6.0 for Windows or InteGrade 
Pro 7.0 for Macintosh.

l Your computer make and model. For example, Dell Dimension XPS 
166 or Apple Power Macintosh 6100/60.

l The computer operating system and version number. For example, 
Windows 98 or Macintosh System 7.5.

l If the product is running on a local area network, the network operating 
system and version number.

Receiving Support from Other Vendors

If you purchased InteGrade Pro student information software from a 
company other than National Computer Systems, Inc., you should contact 
that company for technical support. You should have received information 
on technical support services available from that vendor at the time of 
purchase as well as upon receipt of the product.
14  Where to Find More Information Copyright © 2000 National Computer Systems, Inc.
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Installing InteGrade 
Pro
There are versions of InteGrade Pro for Windows and Macintosh systems. 
The Igpro folder contains both versions on the CD that you received. The 
CD also contains Makedisk functions to create Install programs on 3.5-
inch disks. This enables you to install InteGrade Pro on machines without 
CD drives. Follow the appropriate instructions for the version of InteGrade 
Pro that you are installing.

The CD also contains folders that include the setup needed for InteGrade 
Pro to exchange data with the following administration systems:

l SASIxp

l SASI III

l CIMS

For specific instructions on using InteGrade Pro with one of these 
administration systems, see the InteGrade Pro System Administrator’s 
Guide (IGPADMIN.PDF) on the InteGrade Pro CD.
Copyright © 2000 National Computer Systems, Inc.  15

http://k12.ncs.com/


Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
Windows Version
The Windows version of InteGrade Pro runs on Windows95, Windows NT 
Workstation, and Windows 98. It also supports the Windows NT Server 
and Novell NetWare network operating systems.

System Requirements

l Windows 95, 98, 2000, or NT 4.0 (SP3 or higher)

l A computer that meets the requirements for the version of Windows 
that you are running. 

l At least 10 MB available hard disk space

l At least 8 MB RAM

Scanning Requirements

Scanning is available only in the Windows environment. The following 
NCS scanners are supported: 

l OPScan 2, 3, 4, 4XP, 5, 6, 7, 8, 10, or 21 scanners;

l OpScan 9010M scanner

l OpScan 9020M

Note Sentry 3000 series and OpScan 3000 and 4000 series scanners are 
not supported.

Scan Forms Supported

The following standard NCS SelfScore Forms can be scanned:

l 94746 - 200W test sheet

l 95141 - 25/25 test sheet side

l 95142 - 50/50  test sheet side

l 95676 - 40/W test sheet

l 95677 - 100W test sheet

l 95679 - 100/100 side test sheet

l 95945 - 50 W/W test sheet

l 95946 - 50/W test sheet

l 95947 - 50W/50W test sheet side

l 96569 - E25/W test sheet
16  Windows Version Copyright © 2000 National Computer Systems, Inc.
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l 98253 - E25 test sheet

l 98255 - 50 test sheet

l 106173 - 100 test sheet

Directory Structure Created

Installation of the InteGrade Pro student information software creates a 
directory called SFWTOOLS in the IGPRO directory which contains 
ScanTools.

Installation Configurations

There are three ways to install InteGrade Pro. Choose the installation 
method appropriate for you.

l Install using the installation programs, directly from the CD, on a stand-
alone computer or on a network server.

l Create installation disks (on formatted, 3.5-inch disks) using the Make-
disk program on the CD, then install InteGrade Pro on any stand-alone 

Directory Files Description

\IGPRO\SFWTOOLS config.sfw
sfw.exe
sfwedit.dll
sfwgen.dll
sfwscor.dll
sfwslk.dll

ScanTools run-time 
scanning module 
executable files.

\IGPRO\SFWTOOLS\
Apps

Z600.sds ScanTools reserved 
directory for run-time 
application files.

\IGPRO\SFWTOOLS\
Data

100.dat ScanTools reserved 
directory for data files. 
Data files are created and 
deleted as ScanTools runs.

\IGPRO\SFWTOOLS\
Profiles

ScanTools reserved 
directory for conversion, 
edit, and score profiles; 
directory required even if 
no profiles are used.
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computer or network server without a CD drive. 

Note: You cannot run InteGrade Pro from the installation disks. You must 
install it on the hard drive.

l Install on a client computer from a network server.

Installing on a Computer or Network Server

Use this method to install a single copy of InteGrade Pro, or if you intend to 
run InteGrade Pro directly from the network serve. 

1. Start Windows or the server. If you are installing on a network server, 
be sure you have access rights to create directories and files.

2. Insert the InteGrade Pro CD in the CD drive.

3. Open the Igpro folder on the InteGrade Pro CD, open the Win folder, 
then the Install folder.

4. Double-click the Setup icon (or run the SETUP.EXE file) and follow the 
directions on each dialog box.

5. If prompted for authorization information, go to “Authorizing InteGrade 
Pro” on page 22. Otherwise, your installation is complete.

Note: If InteGrade Pro is running from a network file server, teachers 
access their gradebooks from the network.

Note: Also, if InteGrade Pro is installed on a network server, multiple 
teachers can run the same InteGrade Pro application from different 
workstations. The workstations must be attached to that server. Make sure 
all client users of InteGrade Pro on the server use the same drive letter to 
map their workstations to the application (for example, D:\). 

Creating Installation Disks 

Use this method to install InteGrade Pro on a computer that does not have 
a CD-ROM drive. You must have access to a computer with a CD-ROM 
drive to create the installation disks.

1. Start Windows or the server on a computer with a CD drive.

2. Insert the InteGrade Pro CD in the CD drive.

3. Open the Igpro folder, then the Win folder, then the Makedisk folder.
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4. Double-click the Makedisk icon (or run the MAKEDISK.EXE file) and 
follow the directions in each dialog box. You need two formatted, 3.5-
inch disks for this procedure.

5. When the Installation disks are complete, you can use them to install 
InteGrade Pro on any stand-alone computer or network server.

Note: For InteGrade Pro installation using the newly created, 3.5-inch 
disks, start Windows or the server and insert Installation Disk 1 in the disk 
drive. Double-click the Install icon and follow the directions in each dialog 
box. If the system prompts you for authorization information, go to 
“Authorizing InteGrade Pro” on page 22.

Installing From a Network Server

Use this method if you need to install InteGrade Pro on a large number of 
computers connected to a network server.

1. Start the network file server. Be sure you have access rights to create 
directories and files.

2. Create a separate installation directory. This directory can have any 
name.

3. Copy the contents of InteGrade Pro Install folder from the Igpro\Win 
folder on the CD into the new installation directory.

4. From each client computer, run SETUP.EXE from the installation 
directory on the network server. Follow the instructions on the screen.

The system prompts you to authorize the system the first time you run 
SETUP.EXE from a client computer. Authorizing subsequent 
installations from the network server is not necessary. See page 
Starting InteGrade Pro for help on authorization.

Macintosh Version
The Macintosh version runs on most Macintoshes, including Power 
Macintoshes.
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System Requirements

l System 7.5 or later

l At least 10 MB available hard disk space.

l At least 8 MB RAM

Installation Configurations

There are three ways to install InteGrade Pro. Choose the installation 
method appropriate to you.

l Install using the installation programs, directly from the CD, on a stand-
alone Macintosh or on a network server.

l Create installation disks (on formatted, 3.5-inch disks) using the Make-
disk program on the CD, then install InteGrade Pro on any stand-alone 
Macintosh or network server without a CD drive.

Note: You cannot run InteGrade Pro from the installation disks. You must 
install it on the hard drive.

l Install on a Macintosh client from a network server.

The Macintosh needs the following extensions installed to read the 
InteGrade Pro CD:

l Foreign File Access

l ISO 9660 File Access

Note: These extensions install during a standard system software 
installation. If you perform a custom installation, verify that these 
extensions are installed by clicking the Apple Menu, selecting Control 
Panels, then Extensions Manager.

Installing on a Macintosh or Network Server

Use this method if you are installing a single copy of InteGrade Pro, or if 
InteGrade Pro will run directly from the network server.

1. Start the Macintosh or the file server. If installing onto a network server, 
be sure that you have access rights to create directories and files. 
Macintosh Services must be running on the server.

2. Insert the InteGrade Pro CD in the CD drive.
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3. From the Igpro folder on the CD, open the Mac folder, then the Install 
folder.

4. Double-click the Install icon and follow the directions on the screen. 
Check the appropriate box to install InteGrade Pro on a 68k Macintosh 
or on a Power Macintosh. If you do not know which computer you are 
installing to, click the Apple Menu and select Apple System Profiler. 
The type of processor displays on this screen.

5. If prompted for authorization information, go to “Authorizing InteGrade 
Pro” on page Starting InteGrade Pro. Otherwise, your installation is 
complete.

Note: If InteGrade Pro is running from a network file server, teachers 
access their gradebooks from the network.

Note: Also, if InteGrade Pro is installed on a network server, multiple 
teachers can run the same InteGrade Pro application from different 
workstations. The workstations must be attached to that server. 

Creating Installation Disks

Use this method if you need to install InteGrade Pro on a Macintosh that 
does not have a CD-ROM drive. You must have access to a computer with 
a CD-ROM drive to create the installation disks.

1. Start the Macintosh or the file server (must have a CD drive).

2. Insert the InteGrade Pro CD in the CD-ROM drive.

3. Open the Igpro folder on the CD, then double-click the Mac folder, then 
the Makedisk folder.

4. Double-click the Makedisk icon and follow the directions in each dialog 
box. You need three formatted, 3.5-inch disks for this procedure.

5. When the three installation disks are complete, you may use them to 
install InteGrade Pro on any stand-alone Macintosh or network server.

Note: To install InteGrade Pro using the newly created 3.5 inch-disks, start 
the Macintosh and insert Installation Disk 1 in the disk drive. Double-click 
the Install icon and follow the directions in each dialog box. If prompted for 
authorization information, go to “Authorizing InteGrade Pro” on page 
Starting InteGrade Pro.
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Installing From a Network Server

Use this method if you need to install InteGrade Pro on a large number of 
computers connected to a network server and you are not running 
InteGrade Pro on the server computer.

1. Start the network computer. Be sure you have access rights to create 
directories and files and that Macintosh Services are running.

2. Create a separate installation folder. The folder can have any name.

3. Copy the contents of InteGrade Pro Install folder (from the Mac folder 
on the CD) into the installation folder.

4. From each Macintosh client, double-click the Install icon from the 
installation folder on the network server. Follow the instructions on the 
screen.

Note: The first time the Install program runs from a Macintosh client, the 
system prompts you for authorization. Authorizing subsequent installations 
from the network server is not necessary.

Authorizing InteGrade Pro
The system administrator may authorize the school’s copy of InteGrade 
Pro and distribute it to the teachers.

A teacher who receives an authorization prompt during installation should 
either contact the system administrator or follow the instructions in this 
section.

To complete the authorization dialog, locate the authorization letter that 
accompanied the InteGrade Pro package and enter each field exactly as 
shown in the letter.

If you are installing InteGrade Pro from installation disks created from the 
CD, the authorization process records your authorization information 
directly onto the installation disk. You can copy the installation disk and 
distribute them to teachers who can install InteGrade Pro without having to 
re-enter the authorization information. 

To make sure the installation disks authorize in this way, do not remove the 
installation disks from the disk drive until the system prompts you to, or 
until the installation finishes.
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Note: If you want authorization information saved for distribution to 
teachers, you must create installation disks from the CD and follow the 
procedure described above. Authorization information saves to the 
installation disks, not the CD.

Be sure to keep the authorization letter and the authorized installation 
disks in a safe place.

Note: If you are not able or not ready to authorize during installation, click 
Cancel or Demo (Macintosh). The authorization process automatically 
resumes the next time you start InteGrade Pro. If you click Run Demo, the 
program you have just installed becomes a fully functional demonstration 
version with all features enabled, except the Save command. 

Starting InteGrade Pro 

Windows

1. Click Start, Programs, InteGrade Pro, InteGrade Pro for Windows 95 or 
NT. The system displays the Open Gradebook dialog box. 

2. Click a gradebook and then click Open to open an existing gradebook 
or close the dialog box and select New Gradebook from the File menu 
to create a new gradebook.

Macintosh

1. Double-click the InteGrade Pro icon in the folder in which you installed 
InteGrade Pro. The system displays the Open Gradebook dialog box. 

2. Click a gradebook and then click Open to open an existing gradebook 
or close the dialog box and select New Gradebook from the File menu 
to create a new gradebook.

Using the Sample Data

InteGrade Pro comes with a sample class loaded with data that you can 
use to experiment. This sample class is available whether you are running 
the demonstration or an authorized version of the software. 
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1. Start InteGrade Pro.

2. Select SAMPLE.GBF from the Open Gradebook. The sample class 
loads. 

Try the menu commands. View the Help menu. Enter or change data.

When you have finished experimenting, select Close Gradebook from the 
File menu. To preserve the sample data for the next time, be sure to select 
No when asked to save changes.
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Creating a Gradebook
After you have installed the software, you must create your gradebook and 
set up grading rules. Most teachers create their gradebook by importing a 
class roster file from their schools’ administration database. You can also 
create a blank gradebook and enter your students and classes manually, 
so long as you do not plan to export data at the end of the reporting period. 

Creating A Gradebook By Importing a Class Roster
Before you begin this process, ask your System Administrator for the 
name of the file you need to import.

1. Open the InteGrade Pro student information software and click Cancel 
in the Open Gradebook dialog box.
If the product and the sample gradebook are already open, from the 
File menu, select Close Gradebook.

2. From the File menu, select New Gradebook. 

3. In the New Gradebook dialog box, click Next.
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4. Select Create using class rosters and click Next.
This option creates a gradebook by importing (or “receiving”) class 
roster files from an administration system. This lets you export (or 
“send”) your final grades back to your office administration system at 
the end of a reporting period.

5. Review the instructions on the dialog box and click Next.

6. On the Import File dialog box, select a class roster file to import. This 
file is named CLxxxxxx, where xxxxxx represents your teacher code.
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7. Click Open. 

8. Review the information on screen to ensure that you have the correct 
file, then click Next.

9. In the teacher name field, type your name the way you want it 
displayed on reports. 

You can edit the Incomplete symbol. You can also edit this symbol from 
the Setup menu, on the Grading Rules dialog box, on the Special 
Scores tab.

10. If you choose, set up a password for your gradebook. Click Set 
Password and enter a password. Click Save.
You can also add the password later from the Setup menu, on the 
Passwords dialog box.

11. The Save As dialog box displays. Select a name for your gradebook 
and click Save.
If you are creating a gradebook using a Macintosh and you want to use 
your gradebook with both Macintosh and Windows computers, you 
must save your gradebook with an ending of .gbf. For example, 
JONES98 needs to be saved as JONES98.GBF.

Opening and Closing Gradebooks
Every time you open this product, you are prompted to open a gradebook. 
You can have only one gradebook open at a time. If you need to open 
another gradebook:
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1. From the File menu, select Close Gradebook.

2. The system prompts you to save these changes before you close the 
gradebook.
Closing a gradebook does not automatically exit the system. After 
closing the gradebook, you can either exit or open another gradebook.

3. From the File menu, select Open Gradebook. 
This menu item appears dimmed if a gradebook is already open.

4. Locate and select the appropriate gradebook. 

5. Click Open.

Saving a Gradebook

Save your data as you work. It’s your best insurance against losing data.

l From the File menu, select Save Gradebook.

or

l Use the keyboard shortcut of Ctrl S (Windows) or � S (Macintosh).

Saving Automatically

You can choose to have your data saved automatically at regular intervals.

1. From the Edit menu, select Preferences.

2. Select how often you want your gradebook saved. You can choose any 
interval from 3 to 30 minutes.

3. Click OK.
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Going Back to an Earlier Version

If you have been working in a gradebook and decide that the changes you 
have made are not what you really want, you can quickly go back to the 
last version that you saved.

l From the File menu, select Revert to Saved.
The current version closes and the last version that you saved opens.

Importing Data to a Gradebook 
Importing data is the preferred method of adding students and classes to 
your gradebook. Only by importing data from your school’s administration 
system can you electronically export data back to the main office at the 
end of a term.

Importing Rosters, Comments, or Scores

The class roster file is the most central piece of information imported. For 
class rosters, the import process brings demographic data, letter grade 
tables, and other data associated with the student and class rosters. The 
exact information imported can vary depending on the administration 
system providing the data.

1. Open the gradebook into which you want to import data.

2. From the File menu, choose Import into Gradebook.

3. Select the file and click Import.

Most people import at the beginning of the school year, but you can run the 
import process at any time. For example, if many students transfer into 
your classes, the main office can give you an import file to update your 
gradebook. This file adds new information to your gradebook, but does not 
change existing information.

Importing Tasks, Spreadsheets, or Classes

This feature of InteGrade Pro student information software lets you import 
one or more tasks or spreadsheets or classes from another gradebook into 
your own. 
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1. From the Task Menu, select Import Tasks. 

2. On the Import Tasks dialog box, click Save Gradebook Now, then click 
Next.

3. Select the gradebook file you want to import from and click Open.

4. Choose whether you want to import classes, spreadsheets, or tasks 
and click Next. 
You can import tasks only from numeric or skill spreadsheets.

5. Select the specific items you want to import from that gradebook to 
yours. Use the All and None buttons to quickly select and deselect.

6. Click Import.

When Importing From Other Products

InteGrade Pro student information software can work with data from the 
following NCS products:

l SASIxp

l SASI III

l CIMS

l TSS/TESS

l Osiris

For complete details of importing from and exporting to other products, 
please see the InteGrade Pro System Administrator’s Guide.

Abacus

Before you can import an ABACUSxp file, you must import a related 
SASIxp CLxxxxxx.GRD file.

Previous Versions

Users of previous versions of InteGrade Pro student information software 
can open their gradebooks directly with version 7.00. However, if you save 
a previous gradebook in 7.00, these gradebooks are incompatible with 
previous versions of the product.
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InteGrade Classic

Users of InteGrade Classic must use the import feature (after creating a 
blank gradebook) to convert their class files to the new gradebook format. 
You cannot directly open an InteGrade Classic class file in InteGrade Pro 
student information software. Once converted to the new format, 
InteGrade Classic cannot open an InteGrade Pro student information 
software gradebook file.

CIMS

If you are using CIMS as your administration system, you need to convert 
files from the CIMS format into the InteGrade Pro student information 
software format using the InteGrade Pro/CIMS File Converter before 
importing. See the InteGrade Pro System Administrator’s Guide 
(IGPADMIN.PDF on the InteGrade Pro CD) for instructions on using this 
converter.

TSS

When data is imported from TSS, the student status may be changed in 
certain cases where the student is not in a TSS class list. The following 
table shows the results of importing data from TSS.

Reviewing Imported Data 

After importing student and class data, you should confirm that the data 
has copied correctly into your gradebook.

Look for fields that are blank when you know that there should be data, or 
fields that show unrecognizable characters. If you find any indication of 
corrupt or missing data, close the gradebook without saving or delete the 
corrupt data. Begin the import process again with a new file provided by 
your system administrator.

TSS Status

InteGrade Pro Status

Previously Active Previously Inactive

In Class List Leaves student in 
active status

Changes student to active, but 
leaves the inactive note

Not in Class 
List

Changes student 
to inactive status

Leaves student in inactive 
status
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Student Data
1. From the Setup menu, select Students.

2. Review the list of students in the Students dialog box.

3. Click on several students at random and review the tabs to the right of 
the list. Importing does not fill in every field for all tabs. You can enter 
additional student information at this time.

4. Click Close when you are finished reviewing.

Class Data
1. From the Setup menu, select Classes.

2. Review the list of classes in the Classes dialog box. 

3. Review the tabs for several of the classes. Check that the Students tab 
contains the number of students that you expect to have in that class. 
You can enter additional class information at this time.

4. Click Close when you are finished reviewing.

Importing Automatically from Your Administration System

When you install InteGrade Pro student information software, you can 
choose to automatically update your gradebook every time you open it. 
You can also choose to do this from within the system.

Before you can receive automatic updates from your administration 
system, you must first have imported a class roster file from the 
administration system.

You can only receive automatic updates from the administration system if 
your computer and the administration system are networked together.

1. From the Edit menu, select Preferences.

2. Select Update Gradebooks Automatically and click OK.
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If this feature is selected, when you open a gradebook, the system 
searches for the latest CLxxxxxx.GRD file exported by the administration 
system. This file imports data to update class rosters, class and student 
information, and inactive students. A progress bar displays indicating the 
status of the automatic update. When an automatic update finishes, a 
message displays stating that the process is complete.

Note: For Windows users, you must choose your import file from a 
mapped network drive. It must start with a drive letter (for example, 
G:\igpro\CLxxxxxx.grd.) 

If for some reason you need to run the product on a stand-alone computer, 
you can switch off the network feature. When you want to go back to the 
network, you can switch it back on.

It doesn’t matter whether InteGrade Pro student information software links 
to an administration system via a network or if you run both this system 
and your administration system from a stand-alone computer; InteGrade 
Pro student information software must be able to find the class roster file 
for the update to work.

Error Messages

l If the system cannot find the location of your class roster file to update 
the gradebook, the following message displays:

InteGrade Pro was not able to update your gradebook 
because it could not find the following location:

The path the system is looking for displays (for example, C:\igpdata). 
Click Browse to specify another location or check the box to work off-
line.

l If the system cannot find a class roster file corresponding to the 
gradebook file being opened, the following message displays:

InteGrade Pro was unable to update your gradebook 
because it could not find a class roster file for your 
gradebook in the following location:
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The path the system is looking for displays (for example, C:\igpdata). If 
you cannot find the correct path, contact your network administrator.

l If the system cannot update your gradebook for some reason (for 
example, the network connection is down), you can still open your 
gradebook. If this happens, the following message displays:

InteGrade Pro was unable to update your gradebook 
because it found problems importing a class roster file 
from your administration system.

Contact your network administrator for help in updating your 
gradebook.

Setting Up Grading Rules
Use the Grading Rules dialog box to set up attendance codes, grade 
tables, special scores, and type sets. 

Setting Up Attendance Codes

Attendance codes are used to explain why a student is absent. If you 
created a gradebook by importing a class roster file from an administration 
system, you must use the existing system codes, so that the file exports 
correctly.

The following table lists the system codes and their late and absent values. 
These codes are used in the Class Attendance report and the Student 
Attendance report where the summaries list Late, Absent, and Present. 
For example, a Tardy and an Excused Tardy both are included in the Late 
category, and an Excused counts as an Absent. If you create a new 
attendance code, you must assign one of these system codes to it, so that 
those reports are created correctly.

Code Late Absent

Activity 0 0

Dismissed 0 0.5

Excused 0 1

Excused Tardy 1 0

Not Enrolled 0 0
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.

1. From the Setup menu, select Grading Rules. Click the Attendance 
Codes tab.

2. Review the existing codes. These default codes are either provided by 
the product or imported from your administration system when you 
import a class roster file.

3. If necessary, click New to create a new attendance code. 

l If you create a new attendance code in a gradebook created by 
importing a class roster file from an administration system, you 
must assign one of the existing system codes to it.

l If you create a new attendance code in a gradebook that was 
manually created, you must assign one of the default system codes 
to it. For example, E = default user code and Excused is the valid 

Present 0 0

Suspended 0 1

Tardy 1 0

Undefined 0 0

Unexcused 0 1

Unexcused Tardy 1 0

Unverified 0 1

Code Late Absent
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system code.

4. Click Close. 

Setting Up Grading Tables

Grade tables associate a letter grade with a certain range of scores. 
InteGrade Pro student information software comes with three default 
grade tables.

You assign a grade table to your numeric spreadsheet when you set up 
your spreadsheets from the Setup menu.

1. From the Setup menu, select Grading Rules. Click the Grade Tables 
tab.

2. Select each sample table and review the letters and the assigned 
lower grade limit.

3. Working with grade tables:

l To create a new grade table, click the New button from the set of 
buttons under the Grade Tables list. Type the name of this grade 
table and click Create.

l To create another grade table by copying, select a table and click 
Copy. The new grade table has “copy” at the end of its name.

l To rename a grade table, select the table and type its new name in 
the Grade Table Name field.

4. Working with grades:
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l To create a new letter grade, click the New button from the set of 
buttons under the Letter Grade and Lower Limit area. With that cell 
selected, type the letter, then select the adjoining cell and type the 
lower limit for that grade.

l To modify one of the grades, select that cell and overwrite its 
contents.

l To sort the grade table from highest to lowest percentage, click the 
Sort button from the set of buttons under the Letter Grade and 
Lower Limit area.

5. If necessary, select the number of decimal points that you want 
displayed.

6. Click Close. The table is now available for use, but it is not saved until 
you save the gradebook.

Setting Up Special Scores

A special score is a numeric score represented by a text label.

1. From the Setup menu, select Grading Rules. Click the Special Scores 
tab.

2. Review the special scores that are already predefined for your 
convenience.

l To modify the score for any of the predefined special scores, select 
the score and type its new value in the Score Value field.

l To modify the name for any of the predefined specia scores, select 
the score and type the new name in the Score Symbol field.
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l To create a new special score, click New, type a name, and define 
the value.

l To delete a special score, select the score, click Delete, and click 
Yes to confirm the deletion.

3. Review the symbol used to indicate an incomplete score. The default 
is INC.

4. Click Close.

Setting Up Type Sets

Type sets let you group task types into categories. The system comes with 
sets already defined.

You assign a type set to a particular class when you select Classes from 
the Setup menu.

1. From the Setup menu, select Grading Rules. Click the Type Sets tab.

2. Review the list of Types (Homework, Exam, Quiz).

3. To create a new Type, click New Type, type its name, and click Create.
The type appears in the list at the left of the dialog box.

4. Review the Sets (Humanities, Science, Elementary).

5. To create a new Set, click New Set, type its name, and click Create.
The set appears as a column heading across the top of the dialog box.
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6. To add a Type to a Set, fill in a numerical weight in the appropriate cell 
in the Type Set chart. You do not need to assign all the sets you create. 
The numbers do not have to total 100.

7. Click Close.

Modifying Type Sets

First, select a cell in the grid to choose the type or set to modify.

l To rename a Type, click Rename Type, enter the new name, and click 
Rename.

l To rename a Set, click Rename Set, enter the new name, and click 
Rename.

l To delete a Type, click Delete Type. Click Yes to confirm the deletion or 
No to cancel this action.

l To delete a Set, click Delete Set. Click Yes to confirm the deletion or No 
to cancel this action.

Creating a Gradebook Manually 
Note: The preferred method for adding students to a gradebook is to 
import the class rosters from an administration system. If you enter your 
student data manually and do not import data, you will not be able to 
export grades back to an administration system because there is no 
EndTerm spreadsheet.

1. Open the product and click Cancel in the Open Gradebook dialog box.
If the product and the sample gradebook are already open, from the 
File menu, select Close Gradebook.

2. From the File menu, select New Gradebook. 

3. In the New Gradebook dialog box, click Next.

4. Select Create without classes or students and click Next.
This option creates a blank gradebook. 

5. In the teacher name field, type your name, as you want it displayed on 
reports. 
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6. If available, you can also edit the Incomplete symbol. 
You can also edit the incomplete symbol from the Setup menu, on the 
Grading Rules dialog box, on the Special Scores tab.

7. If you choose, set up a password for your gradebook. Click Set 
Password and enter a password. 
You can also edit the password from the Setup menu, on the 
Passwords dialog box.

8. Click Save.

9. In the Save As dialog box, select a name for your gradebook and click 
Save.
If you are creating a gradebook using a Macintosh and you want to use 
your gradebook with both Macintosh and Windows computers, you 
must save your gradebook with an ending of .gbf. For example, 
JONES98 needs to be saved as JONES98.GBF.

Adding Students 

You can manually enter data at any time after creating your gradebook. If 
you have manually created a gradebook:

1. From the Setup menu, choose Students.

2. Click New, then click Next.

3. Enter the student’s first and last name and student number. The name 
is a required field. 

4. Click Next.

5. Select the class or classes to which you want to add the student. 
Use the All or None buttons to speed up your selection.
If a class is not there, you will have to add it and return to this step 
later.

6. Click Create.

7. Repeat steps 2-6 for all remaining students. 

8. Click Close when you are finished.
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Note: If you select Show Advanced Fields, you see information used when 
InteGrade Pro student information software shares data with another 
software program. You cannot change the information in these fields. If 
you need to change the field information, contact your System 
Administrator.

Adding Classes 

1. From the Setup menu, choose Classes.

2. Click New, then click Next.

3. Type the class name and click Next.

4. Select a task type set from the drop-down list and click Next.

5. Select the students registered in this class.
Use the All or None buttons to speed up your selection. 
If a student is not there, you will have to add them and return to this 
step later.

6. Click Next.

7. On the New Class dialog box, select the spreadsheets you want 
created and click Create.

8. Repeat steps 2-7 for all classes.

9. Click Close when you are finished.

Note: If you select Show Advanced Fields, you see information used when 
InteGrade Pro student information software shares data with another 
software program. If you click the padlock icon, you can change the 
information in these fields, however you should do so only under the 
direction of your System Administrator.
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Working Securely

Using Passwords

Security is very important when dealing with confidential matters such as 
student grades. We recommend that you set up a password to prevent 
unauthorized access to your gradebook file.

When using passwords, consider the following:

l Leave your password with the school office, in case you forget it or are 
absent and a substitute teacher needs access to your class files.

l Avoid writing down your password and leaving it where someone else 
can find it.

l Delete the password just before archiving your gradebook file. You 
should remove the password so that others can access the file in the 
future.

When creating passwords, avoid obvious ones such as your initials, or the 
names of your children, pet, or spouse. Consider mixing digits and 
characters to form recognizable words, such as 4EST (forest), or XLR8 
(accelerate), or 4MUL8 (formulate). Another secure method is to link 
common words with a special character. For example, WORK+LATE, or 
EAT-LUNCH. This type of password is easy to remember, but very hard to 
guess. 

Note: If you experience problems accessing your gradebook with your 
password or you forget your password, call NCS Technical Support at 
(800) 282-4490 for assistance.

Setting up a New Password

1. From the Setup menu, select Password.

2. Type your password and click Next. 

3. Type your password again to confirm it and click Next. 

4. Click OK to set the password.
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Changing a Password

1. From the Setup menu, select Password.

2. Type your password and click Next.

3. Select Change password to.

4. Type the new password and click Next.

5. Type your password again to confirm it and click Next.

6. Click OK.

Deleting a Password

1. From the Setup menu, select Password.

2. Type your password and click Next.

3. Select Remove password protection and click Next.

4. Click OK.

Locking a Gradebook

If you have set up a password for your gradebook, you can lock your 
gradebook quickly, to prevent unauthorized viewing and access.

l From the Setup menu, select Lock Gradebook, or press Ctrl + K.
If you have not set a password, this choice is grayed out.

The following screen displays, hiding the data in your gradebook.
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Unlocking a Gradebook

When you are ready to work in the product, unlock the gradebook.

1. Click Unlock.

2. Type your password in the dialog box that displays.

3. Click OK.
The gradebook is unlocked and you can see the data.

Locking and Unlocking Scores

After you have entered scores for a particular task, you can lock them so 
that they cannot be accidentally overwritten.

1. From the Tasks menu, select Edit Task.

2. Select the Points tab.

3. Select a task.
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4. Select Scores Locked.

5. Click Close.
You cannot change the scores for that particular task.

l To unlock the scores, deselect Scores Locked.
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Working With 
Spreadsheets
InteGrade Pro student information software provides a Numeric and a Skill 
spreadsheet for each class by default. An EndTerm spreadsheet is created 
when you import a class roster file from your administration system. You 
can also create an Attendance spreadsheet.

For organizational purposes, you can define as many spreadsheets as you 
need for a particular class. Many users create separate numeric 
spreadsheets for each term or semester.

As you work, you can open more than one class viewer to be able to 
switch quickly from one spreadsheet to another. 
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Managing Spreadsheets
Use the Spreadsheets dialog box from the Setup menu to manage your 
spreadsheets.

Creating a New Spreadsheet

1. Select the class that you want to use the spreadsheet for.

2. From the Setup menu, select Spreadsheets. 

3. Click New. 

4. From the New Spreadsheet dialog box, select the type of spreadsheet 
you want to create. 

l If you select an Attendance spreadsheet and click Next, you must 
enter a spreadsheet name as well as a start and end date.

l If you select Numeric spreadsheet and click Next, you must enter a 
spreadsheet name.

l If you select Skill spreadsheet and click Next, you must enter a 
spreadsheet name.

5. Click Create.

6. You may choose to select the Notes tab and type a short description of 
this spreadsheet.

7. Click Close.
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Renaming a Spreadsheet

1. Select the class that uses the spreadsheet you want to rename.

2. From the Setup menu, select Spreadsheets.

3. Select the spreadsheet to rename.

4. On the General tab, type a new name in the Name field.

5. Click Close.

Deleting a Spreadsheet

1. Select the class that uses the spreadsheet you want to delete.

2. From the Setup menu, select Spreadsheets. 

3. Select the spreadsheet. 

4. Click Delete.

5. Click Yes to confirm the deletion.
When you delete a spreadsheet, all tasks, scores, spreadsheet notes 
for the students, and score notes are permanently lost.

Changing the Look of a Spreadsheet
You can choose your preferred date format, the titles for the extra (user-
defined) fields, and how you want your spreadsheets to appear. The spell 
checking options are described in “Checking Your Spelling” on page 103.
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1. From the Setup menu, select Display.

2. Click the Date tab to make changes to the date settings. InteGrade Pro 
always stores the year within the program as a 4-digit number, but you 
can choose how you want to see the date displayed. The sample date 
in the lower right corner changes to reflect your settings.

3. Click the Extra Field Titles tab to change the titles for five extra student 
fields and five extra task fields. For example, you may want to name a 
student field Locker. You can change these titles at any time. 
To see these fields in use, from the Setup menu, select Students, then 
click Schools.
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4. Click the Spreadsheet tab to customize the appearance of your 
spreadsheets. 

You can change the visual appearance including whether or not to 
display ledger lines and highlight the selected row and column. You 
can also select the colors of:

l Rows as they display
l The selected row or column 
l Text you can edit
l Text you cannot edit
l Corner clips 

Changes affect all spreadsheets. The sample spreadsheet changes to 
reflect your choices. If you don’t like the look, click Reset Colors to 
revert to the default colors.

5. If you want to see the shortened form of the task names, select Show 
Task Short Name.

6. If you want to see inactive students, or the students’ last names first, 
make those selections.

7. Decide how wide you want the columns to be. You can select from 7 to 
14 characters wide. The wider the column, the more of the headings 
you see.

8. Click Close.
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Customizing Spreadsheet Columns

Depending on the spreadsheet you selected, and the view, you can 
customize the columns for students, tasks, and types. Changing the 
column names does not affect the data. If you want to see two of the same 
columns at once, open another class viewer. For example, you might want 
to see two different student demographics.

1. Select the spreadsheet you want to customize.

2. From the View menu, select Change Columns.

l Numeric Spreadsheet, Task view
On a Numeric Spreadsheet, with the View selected as Task, you 
can customize six columns for student information and six for tasks. 

l Numeric Spreadsheet, Type view
However, if the View is selected as Type, you can change any of 
five statistics on the Type tab, in addition to the six columns of 
student information as shown above

l Skill Spreadsheet
On a Skill Spreadsheet, you can customize one column for student 
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information and six for tasks.

l EndTerm Spreadsheet
On an EndTerm Spreadsheet, you can customize one column for 
student information.

l Attendance Spreadsheet
On an Attendance Spreadsheet, you can customize one column for 
student information.

3. Select or deselect the columns to view. If you deselect a column, it is 
no longer visible on the spreadsheet. 
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4. Using the drop-down lists, select what information you want to see in 
that column.

5. Click Close. 

Other Ways to Change Columns

There is a shortcut to change columns, directly on the spreadsheet.

1. On the spreadsheet, click the blank column heading cell to the left 
(Windows) or right (Macintosh) of either the Task or Student columns.

2. Select Change Columns from the drop-down list. 

3. On the Change Columns dialog box, make the appropriate changes 
and click Close.

OR

l Click the column header of an auxiliary column and select the 
information you want displayed from the drop-down list. Rememer that 
you must first use the Change Columns dialog box to select a column 
to display.
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Managing Student Data
InteGrade Pro student information software helps you manage the student 
data you work with each day. You can add students to classes, view or 
change the demographic information for students, or confidentially show 
their progress to parents or students themselves.

Viewing or Modifying Student Data

As a general rule, you should never add students to a gradebook that you 
have imported from an administration system. If you do so, the next time 
you update your gradebook from the administration system, that student 
will disappear. However, if you have created a gradebook manually, and 
you are adding students, see “Adding Students” on page 40.

1. From the Setup menu, select Students. 

2. From the drop-down list in the upper left corner, select the class whose 
students you want to see, or select All Students.

3. Select the student to view or modify. 

4. Select the tabs, viewing, entering or editing information. The only 
required field is the student’s name. 

5. The Personal tab is used for demographic information. 
Use the Unknown gender when entering students from a list if you are 
not sure of the gender.
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6. The Contacts tab is used for the address and phone numbers for this 
student. Besides the Primary contact, you can also create a Parent/
Guardian, Emergency, Physician, Mailing Address, and Other Contact 
Type.

If an email address is available, you can select Send email reports to 
this contact.

7. The School tab is used for school information like grade, homeroom, 
and counsellor that you need to track for this student. 
You can use another dialog box to change the extra field titles to say 
something more meaningful. From the Setup menu, select Display, 
then click the Extra Field Titles tab and make your changes.
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8. The Classes tab shows which classes a student is enrolled in. If there 
are no classes selected, it means the student is not enrolled in any of 
them.

9. The Scores tab shows how the student is performing on their tasks. 
You can select which spreadsheet to use from the Spreadsheet drop-
down list at the top of the tab.
If you have chosen to show “All Students”, the Scores tab appears 
dimmed.
This tab can be used for data entry and for showing a single student’s 
scores. You can customize two of the rightmost columns by clicking on 
the header cell and selecting a new heading.

10. The Stats tab Shows how a student fared on a single task, using 12 
different score transformations.
Select which spreadsheet and task to use from the drop-down lists at 
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the top of the tab.
If you have chosen to show “All Students”, the Stats tab appears 
dimmed

11. The Notes tab records your comments about a student. You can keep 
separate notes for each spreadsheet.
If you have chosen to show “All Students”, the Notes tab appears 
dimmed.
A small red marker in the lower-right corner of the cell on the 
spreadsheet indicates that notes exist for that student.

12. Click Close.
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Adding Student Contacts

1. On the Contacts tab of the Students dialog box, click the New button 
under the list of contacts.
A New Contact appears in the list of contacts, of a type Other.

2. In the Contact Type drop-down list, select the type of contact this is.
The symbol beside the name changes, according to the type of contact 
selected.

3. Type the name, address, and phone numbers.

Deleting Students

You can delete a student from the gradebook, from a class, or merely 
inactivate them. Deleting from the gradebook removes all information 
about a student, including demographic data and scores. Use this option 
only if a student has permanently left your school and you do not need 
records for the student. 

1. From the Setup menu, select Students. 

2. Select the appropriate class from the drop-down list at the top of the 
dialog box, or select All Students.

3. Select the student to delete.

4. Click Delete.
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5. On the dialog box that displays, choose to delete from the gradebook, 
remove from a class, or make the student inactive.

6. Click Delete, Remove, or Inactivate, depending on which choice you 
made. You do not have to confirm the action.

Sorting Students

Sort orders that you select here are reflected in the reports.

1. From the View menu, select Sort Students. 

2. Decide how you want to sort the students:

l Name
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l Demographic data like birth date, first name, gender, or one of the 
16 choices available from the by Demographic drop-down list

l Task Score by selecting a task from the by Task Score drop-down 
list

l Spreadsheet Grade

3. Choose the sort order, either ascending (A-Z) or descending (Z-A).

4. Click Sort.

5. Click Close.

Other Ways to Sort Students

l On the spreadsheet, click any column title in the Student area and 
select Sort Students. The Sort Students dialog box displays. Make your 
selections and click Sort.

l On the spreadsheet, click any column title in the Student area and 
select Sort Students by Column. Student are sorted in the order of the 
scores in that column.

l Click anywhere in the Student area of the spreadsheet and right-click 
(Windows) or Ctrl-click (Macintosh) and select Sort Students by Column 
or Sort Students from the context menu.

Scrambling the Order

Use the Sort Students dialog box to arrange your students in random 
order. You could use this if you wanted to post a report and you didn’t want 
student names listed in any particular order. 

1. From the View menu, select Sort Students.

2. Click Scramble.

3. Click Close.

Sorting Manually

To sort manually within the Sort Students dialog box, hold down the 
<CTRL> key (<�>in Macintosh) and drag a student name to a new 
position. 
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Managing Class Data

Viewing or Modifying Class Data

1. From the Setup menu, select Classes. 

2. From the list at the left, select a class.

3. The General tab is used for information about this class. Use the drop-
down lists to assign task type sets and spreadsheets (that you have 
already created) to this class.
Setting the Current Grade Spreadsheet is important when you are 
exporting grade information via InteGrade Pro Link.

.

4. The Students tab is used to assign students to this class. Select a 
class, then a student, and click the right arrow.
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.

5. The Notes tab is used to record your notes about this specific class.
It provides an ideal location for keeping your course syllabus.

6. Click Close.

Creating a Class

After a class is created, you can always add more information or change 
the existing information.
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1. From the Setup menu, select Classes.

2. Click New.

3. Click Next.

4. Type a name. This is the only required field. Click Next.

5. Select a Task Type Set from the drop-down list. Click Next.

6. Register students by selecting their names from the list.

7. Click Next.

8. Choose Weighted Type, Total Points, or Skill.

9. Click Create.

Deleting a Class

If you delete a class, all spreadsheets, tasks, scores, and notes associated 
with that class are also deleted.

1. From the Setup menu, select Classes.

2. Select a class.

3. Click Delete.

4. Click Yes to confirm the deletion.

Adding Students to Classes 

There are two ways to add students already entered into a gradebook into 
classes. You can use either the Classes or the Students dialog box.
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Using Classes Dialog Box

1. From the Setup menu, select Classes, then click the Students tab.

2. Select the student you want to add from the Students not enrolled in 
class column, then click the right-facing arrow. 
The Students enrolled in class column displays the student’s name.

3. Click Close.

Using Students Dialog Box

1. From the Setup menu, select Students, then click the Classes tab.
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2. Select the student you want to add to a class, then select the class or 
classes you want to add them to.

3. Click Close.

Removing Students From Classes

There are three different ways of removing a student from a class. 
Removing a student from a class permanently removes all scores 
associated with that student.

1. From the Setup menu, select Classes, then click the Students tab.

2. Select the student you want to remove from the Students enrolled in 
class column, then click the left-facing arrow. The Students not 
enrolled in class column displays the student’s name.

l Or

1. From the Setup menu, select Students, then click the Classes tab. 

2. Select the student to remove, then deselect the appropriate class.

l Or

1. From the Setup menu, select Students.

2. Select the student to remove, then click Delete.

3. On the dialog box that displays, select Remove From Class.

4. Click Remove.

Making a Student Inactive

You can view an inactive student’s grades up to the date they became 
inactive, even though grades are no longer being calculated.

Inactivating a student does not delete their scores or other information 
from the spreadsheet. A tilde (~) preceding a student’s name (for example, 
~Robert Jones) identifies inactive students on reports and spreadsheets.

Inactive students sort to the end of all student lists when sorted.
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1. From the Setup menu, select Classes, then click the Students tab.

2. Click Student Status. 
A list of students currently enrolled in the selected class displays. All 
students with selected checkboxes before their name are currently 
active.

3. Deselect the checkbox before the name of the student you want to 
make inactive.

4. Click OK. 
The student’s name has a tilde (~) in front of it.

5. Click Close.
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Entering Tasks, 
Scores, and Notes
On a daily basis you add tasks and enter scores and notes. With 
InteGrade Pro student information software, you can also adjust scores in 
several ways. All these functions are available from the Tasks menu.
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Creating a New Task
1. From the Tasks menu, select New Task.

2. Click Next.

3. Type the task name.

4. Enter the date assigned and the due date.

5. Select the type of task from the drop-down list.

6. Enter the “Out of” score.

7. If you choose, you may enter a scale factor.

8. If you choose, you may enter a maximum score (the same as the “Out 
of” score). If you do so, you will be warned if you accidentally enter a 
score higher than the maximum. 

9. Click Create.

 Other Ways to Create Tasks

In addition to using the New Task option on the Tasks menu, you can also 
create new tasks in the following ways:

l Use the keyboard shortcut of Ctrl + N (Windows) or � N (Macintosh) 
l Click the column heading Task Name and select New Task
l Click New from the Edit Tasks dialog box
l Select an existing task and click Copy from the Edit Tasks dialog box; 
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the new task has the word “copy” at the end of its name
l Import the tasks, see “Importing Tasks, Spreadsheets, or Classes” on 

page 29
l Copy the tasks from another spreadsheet, see “Copying Multiple Tasks” 

on page 75.

Editing Tasks

Viewing or Modifying Tasks

1. From the main viewer, select the class whose tasks you want to 
modify.

2. From the Tasks menu, select Edit Tasks. 

3. From the task list at the left, select a task to view or modify. 

4. On the General tab, if you want to change the name of this task, edit 
the Task Name field.

5. Review the abbreviated name for this task that the system created. 
The spreadsheet uses this shorter name. If you want to change the 
name, click Custom and enter a new name.
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6. Review and modify the date fields, if necessary.

7. The selection Allow Export to InteGrade Link is on by default. This is 
used to extract specific task data for other programs.

8. The Advanced Fields are only used on the advice of your System 
Administrator.

9. On the Extra tab, you can record other details about this task. If you 
choose to use these fields, use the Display command from the Setup 
menu to customize these field names.
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10. The Points tab includes all the fields you saw when you created this 
task. You can modify any of these fields. If you do so, all grades are 
automatically recalculated. Select Scores Locked to prevent 
accidentally overwriting the scores.

11. Use the Scores tab to view and modify the scores for this task. This is 
one of the screens where you can enter scores for new tasks. The 
right-most column can be customized by clicking on the column header 
and selecting another score transformation from the drop-down list.
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12. The Stats tab displays 19 different statistical pieces of information 
about this task.

13. Use the Notes tab to record notes about this task.

14. Click Close.
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Deleting Tasks

Deleting a task also removes all scores for that task from your gradebook.

1. From the Tasks menu, select Edit Tasks.

2. Select the task to delete.

3. Click Delete. 

4. Click Yes to confirm the deletion.

Other Ways to Open the Edit Tasks Dialog Box

The Edit Tasks dialog box is the starting point to many task-related 
activities. Open this dialog box using any of the following methods:

l From the Tasks menu, select Edit Tasks.
l Double-click any task name on the spreadsheet.
l Click the column title “Task Name” and select Edit Tasks from the drop-

down menu.

Copying One Task

To quickly copy one task within the same spreadsheet, on the Edit Task 
dialog box select a task and click Copy. 

Note: This way of copying does not bring the scores to the new task.

Copying Multiple Tasks 

You can copy tasks from the same spreadsheet or from another 
spreadsheet. You can copy more than one task at a time.

Copying tasks is a fast way to create a new task that is similar to an 
existing one. Copy the task, then modify it. Remember to give it a new 
name.

This procedure is especially useful for copying more than one task 
between spreadsheets. This procedure brings all the scores with the task, 
if the student name matches.

1. From the Tasks menu, select Copy Tasks.

2. Select a class and a spreadsheet to copy from.
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3. Click Next.

4. Select the task to copy. Use the All or None buttons if they help speed 
up your selections.

5. If you want to move tasks, select Delete original tasks after copying.

6. Click Next.

7. If you want to transform the score while you are copying it, select 
another from the list. Otherwise, leave Raw Score selected and click 
Next.

8. Click OK and the task is copied into your current spreadsheet. It 
appears highlighted.

9. Double-click the new task and change its name.

10. Make other changes to this task, as required.

Replacing A Task With Another

You can replace an existing task with another one.

1. Select the class and spreadsheet that contains the task you want to 
replace.

2. In the Student area of the viewer, click the column title of the task you 
want to replace.

3. Select Replace Task from the drop-down menu.

4. Select a class and a spreadsheet to copy from and click Next.

5. Select the task to copy. Use the All or None buttons if they help speed 
up your selections. Click Next.

6. If you want to transform the score while you are copying it, select 
another from the list. Otherwise, leave Raw Score selected and click 
Next.
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7. Click OK and the task replaces the selected task in your current 
spreadsheet.

8. If necessary, edit the new task and modify it, as required.

Combining Tasks

InteGrade Pro student information software can combine several tasks 
into a new task to help you manage a large number of tasks more 
efficiently. 

This feature will not work as described if one of the scores to be combined 
is an INC (Incomplete) score. The result of combining tasks when one of 
them has an INC score is a combined task with an INC total combined 
score.

As a precaution, print the Spreadsheet report before combining tasks, 
especially if you intend to delete the tasks after combining them. 

1. Select the class containing the tasks you want to combine.

2. From the Tasks menu, select Combine Tasks.

3. Choose whether you want to combine the tasks to total points (15 + 15 
+ 10 = 40) or whether you want to combine to a percentage (a new 
task out of 100) and click Next.

4. Select the tasks to combine. Use the All or None buttons to speed your 
selection.

5. Using the drop-down list, select the task type and click Next.

6. Type the name of the new combined task and select the amount of 
precision for the score. Click Next.

7. Choose whether or not you want to delete the tasks being combined. 
Delete the original tasks only if you no longer need details about the 
individual tasks and if you have printed the Spreadsheet report for 
future reference. Click Next.
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8. Click Combine.
The combined tasks display as a new task at the end of the list. Its “out 
of” value is either the value you specified or the total of all the tasks 
being combined, depending on which option you chose. Its scale factor 
is 0.0, to prevent it from affecting the class totals.

9. Edit the new task and change its scale factor to 1.0 to include it in the 
calculations.

Note: Instead of deleting the original tasks, consider changing their scale 
factor to 0.0. This prevents them from affecting the totals and keeps them 
in your spreadsheet should you decide that you want to use them later. 
You can also save the gradebook under another name to preserve your 
original tasks. When you are satisfied with the merged results, you can 
delete the original gradebook. If not, you can delete the copy.

Sorting Tasks

Sorting tasks lets you quickly see the results the way you want to see 
them.

1. From the View menu, select Sort Tasks.

2. Choose what field you want to sort on:

l By Task Name is the default sort
l By Auxiliary lets you select any of 12 other fields from the drop-

down list
l By Statistic lets you select from one of 19 score transformations 

from the drop-down list

3. Choose the direction of sort. Ascending (A-Z) is the default sort. Your 
other choice is Descending (Z-A).
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4. Click Sort.

Other Ways to Sort Tasks

l On the spreadsheet, click any column title in the Tasks area and select 
Sort Tasks. The Sort Tasks dialog box displays. Make your selections 
and click Sort.

l On the spreadsheet, click any column title in the Tasks area and select 
Sort Tasks by Column. Tasks are sorted in the order of that column’s 
data. For example, if you want to see which task had the highest class 
average, you would sort on the Class Avg column.

l Click anywhere in the Tasks area of the spreadsheet and right-click 
(Windows) or Ctrl-click (Macintosh) and select Sort Tasks by Column or 
Sort Tasks from the context menu.

Scrambling the Order

Use the Sort Tasks dialog box to arrange the tasks in a random order.

1. From the View menu, select Sort Tasks.

2. Click Scramble.

3. Click Close.

Sorting Manually

To sort manually within the Sort Tasks dialog box, hold down the <CTRL> 
key (Windows) or � key (Macintosh) and drag a student name to a new 
position. 

Working with Scores
After your classes are set up and you have entered students and tasks, 
you need to enter scores for those tasks.

You can enter scores in either numeric or skill spreadsheets.

InteGrade Pro student information software does not prevent you from 
entering scores above 100%. To remind you of such scores, a cell has a 
small marker in the upper-right corner if the score is over 100%. This is 
different from a marker in the lower-right corner of the cell, which indicates 
the presence of a note. 
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Using the Edit Tasks Dialog Box

Entering scores in the Edit Tasks dialog box is the easiest way to enter 
data, since the student name is next to the score. The interface is also less 
distracting since only one task is visible at a time. You can customize the 
third column at the right to display the student’s score in a number of ways.

1. Select the appropriate class and spreadsheet.

2. From the Tasks menu, select Edit Tasks.

3. Select a task.

4. Click the Scores tab.

5. Beside each student’s name, enter the scores for that task.

6. Click Close.

Entering Scores On the Spreadsheet

Entering scores in the spreadsheet lets you move quickly between tasks 
and lets you see at a glance how the student fared on other tasks.
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1. Select the appropriate class and spreadsheet.

2. On the spreadsheet, in the Student area of the viewer, locate the 
column labelled with the short form of the task name.

3. Move the cursor to the correct row for the student whose score you are 
entering.

4. Type a numeric score or a special score. 
Or, right-click the cell (Windows) or Ctrl-Click (Macintosh) and select a 
special score from the context menu. Skill scores can include letters 
and numbers, up to seven characters long. These scores are not 
based on grade tables.
Numeric scores that are above the maximum score defined for the task 
generate a confirmation dialog. 

5. Press <ENTER> or one of the four arrow keys to enter the score.
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Using the Students Dialog Box

1. From the Setup menu, select Students.

2. Click the Scores tab.

3. Select the appropriate spreadsheet in the drop-down list.

4. Select a student.

5. Locate the task that requires the score and type the score.

6. Press <ENTER> or one of the four arrow keys to enter the score.

7. Repeat steps 4-6 for each student’s score.

8. Click Close.

Entering Many Scores At Once

If you need to enter the same score for many students and tasks, use the 
Bulk Fill command from the Tasks menu. You can also use the bulk entry 
feature for entering missing scores, or replacing existing scores.

A related command is the Fill Column command, accessed by clicking a 
column title. This command is ideal for quickly entering the same score in 
the entire column. It is also useful for erasing a column by filling it with 
blanks.
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Bulk Fill

1. From the Tasks menu, select Bulk Fill.

2. Select the students who are to receive this score. Use the All or None 
buttons to speed your selection.

3. Selects the tasks that are to receive this score. Use the All or None 
buttons to speed your selection.

4. Type the new score.

5. Select Replace only Empty scores if you want this score going only to 
students who currently do not have a score for this task.

6. Click Fill.

Using the Filter With Bulk Fill

You can create rules to determine which students and tasks should receive 
the score. Once you specify the rules, the scores enter automatically and 
the spreadsheet recalculates.
Copyright © 2000 National Computer Systems, Inc. Working with Scores  83

http://k12.ncs.com/


Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
1. On the Bulk Fill dialog box, click Filter.

2. Click the Filter button below the Students or Tasks area.
You can create and use a filter for students or for tasks, or for both 
students and tasks.

3. Select Show Students Whose or Show Tasks Whose.

4. Select the filter you want to use, and modify it using the drop-down 
lists.
For example, if you want to see only the students who were away with 
the flu, and if you had put the word “flu” in their student score note, 
select Student score note contains and type the word flu.
Or if you want to see the tasks that are due on a certain date, select 
Due Date and use the drop-down lists to complete the expression.

5. Click OK.

6. Type the new score.
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7. Select Replace only Empty scores if you want this score going only to 
students who currently do not have a score for this task.

8. Click Fill.

Filling a Column

1. In the Student area of the viewer, click the column header of the 
column you want to fill.

2. From the menu that displays, select Fill Column.

3. Enter the score you want to use to fill the column.

4. If you want to fill only the blank cells, select Replace only empty 
scores.

5. Click Fill.

Scanning in Scores

This scanning feature of InteGrade Pro student information software 
allows you to scan in scores from a standard NCS scan form. This feature 
is not available on a Macintosh.

This procedure assumes that you have a functioning scanner attached to 
your computer and that you have all the appropriate scan forms ready to 
go. Scores are not actually created in your gradebook until the final step of 
this process. Scanning updates tasks in the current viewer.
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1. From the Tasks menu, select Scan.

2. The name of your scanner displays. 
Click Diagnostics only if you need to test if your scanner is working 
correctly. Use the Scanner Setup button which leads to the Scanner 
Configuration dialog box only on the instructions of your system 
administrator.

3. Click Next. 

4. Choose whether you want the scanned in scores to replace the scores 
of an existing task, or to create a new task.

l If you choose Existing, you must also decide if you want to replace 
all scores or only empty scores.

l If you choose New, you must enter a task name, select its type from 
the drop-down list, and enter a due date.
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5. Click Next.

6. Check that the first form in the scanner is the test answer key and click 
Next.

7. Review the results of scanning the key sheet. If you are satisfied that 
you have the correct forms in the scanner, click Next.
Scanning begins and a progress bar displays on screen. The student 
name of the current sheet being processed displays.

l If a student ID is encountered twice, a dialog box displays asking 
you if you want to replace the data. Clicking Yes replaces the 
original scanned results for that student with the latest scan results. 
Clicking No retains the original scanned results and ignores this 
latest scan.

l If an unknown student ID is encountered, a dialog box displays “No 
such student in class”. Click OK to resume the scanning process. 
The score for the unknown student ID is ignored.

8. When scanning is complete, review the results on screen. If you want 
to print this information, click Print Report.

9. Click Close to create a task and add the scanned results to your 
gradebook.

How Grades Are Calculated
InteGrade Pro student information software always calculates the correct 
grade for a student. The following example show the methodology used to 
calculate that grade. 
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First, assume that the circled Type Set is being used for Mathematics.

Then, divide the points assigned to each type by the total points to 
calculate what percentage each type contributes to the student’s grade. 
For example, Homework is worth 10 points out of 80, or 12.5%.

But these figures hold true only if the student has at least one score for 
each task type. That means until the midterm exam is given, a student will 
have only completed tasks of the other three types. As a result, during that 
time each type will contribute more than the percentage just calculated.

In this case, with no midterm, the total points are only 60 instead of 80, and 
so homework contributes 10 divided by 60 or 16.7% of the overall grade. 

Task Type Points
Total 

Points Percent of Overall Grade

Homework 10 80 10 ÷ 80 = 12.5%

Exam 30 80 30 ÷ 80 = 37.5%

Quiz 20 80 20 ÷ 80 = 25.0%

Midterm 
Exam

20 80 20 ÷ 80 = 25.0%

Total 80 Total Grade = 100%
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Next, let’s assume that the following nine tasks are given for the class:

Since only one midterm exam is given, it is worth the entire 25% of the 
overall grade as noted previously. Likewise, only one exam is given, so it's 
worth 37.5% of the student's grade. 

Quizzes are worth 25% of the overall grade, but there are more than one, 
so their contribution is calculated as follows. If we divide the points 
assigned to each quiz by the total points (53), we see what percentage 
each quiz contributes to the quiz portion of the total mark.

Finally, when the percentage of the overall grade that each task 
contributes is calculated, we arrive at the student's overall grade. The 
following table shows the three quizzes and their contribution to the overall 

Quizzes Points
Ttl. Quiz
Points

% of
Quiz Grade

% of
Overall Grade

Right Triangles 15 53 15 ÷ 53 = 28.3% 28.3% of 25% = 7.1%

Trigonometric functions 20 53 20 ÷ 53 = 37.7% 37.7% of 25% = 9.4%

Sine and Cosine Laws 18 53 18 ÷ 53 = 34.0% 34.0% of 25% = 8.5%

Total 53 25%
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mark, with the % of Overall Grade figures from the previous table, as well 
as the other tasks. This example also includes four “Problems” that are 
homework assignments contributing towards the 16.7% of the total grade.

For the final result, InteGrade Pro student information software calculated 
82% for the student's grade. The system recalculates these grades 
automatically whenever you change a score or a grade rule.

Tasks Score Out Of
%

[score 
÷out of]

 % of
Overall 
Grade

Overall %

[% x % of 
Overall 
Grade]

Pythagorean Theorem 
Problems

8 10 80% 2.7% 2.2%

Right Triangles Quiz 12 15 80% 7.1% 5.7%

Trigonometric 
Functions (Sin, Cos, 
Tan) Problems

11 12 91.7% 3.2% 2.9%

Trigonometric 
Functions Quiz

17.5 20 87.5% 9.4% 8.2%

Inverse Trigonometric 
Functions (S~Cot) 
Problems

11 15 73.3% 4.0% 2.9%

The Cosine Law 
Problems

7.5 10 75% 2.7% 2%

Sine and Cosine Laws 
Quiz

15 18 83.3% 8.5% 7.1%

Trigonometry Midterm 
Exam

61 75 81.3% 25% 20.3%

Trigonometry and 
Statistics Final Exam

82 100 82% 37.5% 30.8%

82%
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Adjusting Scores
Usually, the scores achieved by your students are the ones used to 
calculate their overall grades. However, there are times when you might 
need to adjust the scores. For example, if a test was too hard and class 
scores were significantly lower than expected, you might want to adjust 
them. 

InteGrade Pro student information software offers several commands to 
help you adjust scores fairly. These commands are statistically sound and 
are easier to use than manually altering student scores.

The score-adjusting functions are available only while a numeric 
spreadsheet is active. 

Note: Before altering any scores, you should print the Spreadsheet report. 
This gives you an archive of the original, unaltered scores. If the results 
are not what you expect, you can always back out of any changes if you 
have not saved the gradebook.
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Dropping and Restoring Scores

The Drop/Restore Scores command automatically drops one or more 
scores that are the most damaging to a student’s overall grade. Because 
different task types like quizzes and homework may contribute differing 
amounts to the overall grade, the most damaging score might not 
necessarily be the lowest one. 

For example, suppose you have an equal number of quiz and homework 
tasks. A student receives 3 out of 10 on a quiz and 4 out of 10 on a 
homework task. However, if quizzes account for 20% of the overall grade, 
while homework accounts for 40%, the 4 out of 10 homework task would 
be dropped, even though the quiz score of 3 out of 10 is lower. 

How It Works

The Drop/Restore Scores command tries dropping each score and then 
notes how it affects the student’s overall grade. This procedure applies 
Drop labels—a special type of Excused label—to the number of scores 
requested. 

The Drop label behaves like any other Excused label, except that its name 
is fixed and it does not appear in the Special Scores tab of the Grading 
Rules dialog box. 

The original score still exists beneath the Drop label. If you use another 
score manipulation factor, such as Curve Scores, you can affect the 
original score. 

Drop Scores will not function for any student with an INC (Incomplete) 
score on ANY of their tasks, until an earned score or an Excused label 
replaces the incomplete score.

InteGrade Pro student information software counts Excused scores as 
dropped scores. If a student has the same or greater number of Excused 
labels as the number of scores you are asking to drop, the system will not 
apply additional Drop labels. For example, if a student has two Excused 
labels and you are requesting that the two most damaging scores be 
dropped, that student will have no additional scores dropped.

Caution If you type over a Drop label on the spreadsheet, you replace 
both the Drop label and the original score. You cannot restore the original 
scores if you do this.
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1. Select the class whose scores you want to drop.

2. From the Tasks menu, select Drop/Restore Scores.

3. Select Drop Scores and click Next.

4. Enter the number of scores to drop. You can drop one or more scores.

5. Select the students and tasks to include by manually choosing from the 
list. Use the All and None buttons to speed your selection, or click 
Filter and create rules.

6. Click Next.
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7. Click Drop.

You can undo the Drop/Restore Scores manipulations at any time.

Using the Filter With Drop/Restore

You can create rules to determine which students and tasks should be 
selected to be dropped.

1. On the Drop/Restore Scores dialog box, click the Filter button below 
the Students or Tasks area.
You can create and use a filter for students or for tasks, or for both 
students and tasks.

2. Select Show Students Whose or Show Tasks Whose.

3. Select the filter you want to use, and modify it using the drop-down 
lists.
For example, if you want to see only the students who were away with 
the flu, and if you had put the word “flu” in their student score note, 
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select Student score note contains and type the word flu.

Or if you want to see the tasks that are due on a certain date, select 
Due Date and use the drop-down lists to complete the expression.

4. Click OK.

Restoring Dropped Scores

You cannot manually remove a Drop label to reveal the original score. You 
must use the Drop/Restore Scores function to remove it. 

1. From the Tasks menu, select Drop/Restore Scores.

2. Select Restore.

3. Select the students and tasks to restore by manually choosing them 
from the list, or by clicking Filter and using rules.

4. Click Restore.
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Curving Scores

The Curve Scores command alters scores for a task using one of two 
methods: 

l Curve all scores to fall within a specified low/high range. 

l Curve towards a specified mean and standard deviation.

Curving does not affect Excused scores or INC (Incomplete) scores. They 
remain INC until the student completes the assignment and the teacher 
records a score.

Curving can affect scores under a Drop label.

1. Select the class whose scores you want to curve.

2. From the Tasks menu, select Curve Scores.

3. Select the method you want to use and click Next.

4. Select the task to curve and click Next.

5. Enter the parameters for the method you selected and click Next. 

l If you selected High/Low, you must enter a new high and a new low 
score.

l If you selected Mean/Standard Deviation, you must enter a new 
mean and standard deviation.
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6. Indicate whether the curved task replaces the existing task or appears 
as a new task. 
Because curved scores cannot be “uncurved”, we recommend that you 
choose to create a new task and then delete the original task later 
when you are satisfied with the results. 

7. Enter the name of the curved task and click Next.

8. Click Curve.

9. The new curved task has a scale factor of 0.0. If you decide to keep 
the new curved task, change its scale factor to 1.0 to include it in the 
calculations. 

10. Instead of deleting the original task, consider changing its scale factor 
to 0.0 instead. This prevents it from affecting the totals and provides an 
additional safeguard should you decide to undo the curving later.

Picking the Highest Scores

The Pick Highest Scores command creates a new task with the highest 
score out of a group of specified tasks. You can use this function when a 
student repeats a task and you allow the better of the two scores to stand.

The newly created task is always out of 100 and is of the task type that you 
specified. The system can select the highest score from any number of 
tasks. The tasks do not have to be of the same type, since they are 
compared by percentages.

1. Select the appropriate class.

2. From the Tasks menu, select Pick Highest Scores. Click Next.
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3. Select the tasks to include by manually choosing from the list, or by 
clicking Filter and using rules. Click Next.

4. Enter a name for the new task.

5. Choose a type for the new task and click Next.

6. Click Pick. The new task adds to the end of the list of tasks. It has the 
current date as the Due Date and the Scale Factor set to 0.0, so that it 
does not affect class totals.
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7. The new task has a Scale Factor of 0.0. If you decide to keep the new 
task, change its Scale Factor to 1.0 on the Edit Tasks dialog box to 
include it in the calculations. 

8. Instead of deleting the original tasks, consider changing their Scale 
Factor to 0.0 instead. This prevents the tasks from affecting the totals 
and it provides an additional safeguard should you decide to undo the 
Pick Highest Scores later.

Working With Notes
You can enter notes directly in the spreadsheet in the Notes area, or on 
the Notes tab in the Student or Tasks setup dialog boxes.

Note: Cells with notes have a small marker at the lower-right corner of the 
cell. You can see this in the sample gradebook. This is different from a 
small marker in the upper-right corner of a cell, which indicates that the 
score entered is over 100%.

Notes Area

The Notes area at the bottom of the screen is ideal for teachers who use 
notes frequently, or who comment extensively on skills.

Once the Notes area is visible, you can resize it by dragging the thin blue 
bar at the top of the Notes area. This helps you accommodate long and 
short notes, while conserving screen space.
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The Notes area can record and display notes about tasks, students, and 
student scores on a task. It cannot display notes about the class or 
spreadsheet; for this, you must use the Classes or Spreadsheets dialog 
boxes (accessed under the Setup menu).

Viewing Notes

1. From the Show drop-down menu of the viewer, select one of the views 
that displays notes:

l Students/Notes
l Tasks/Notes
l Tasks/Students/Notes
l Seating Chart/Notes

2. Select the cell containing the note to view. The Notes area displays at 
the bottom of the screen. 

Other Way to View Notes

From the View menu, select Show Notes.
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Entering Notes in Notes Area

1. Select the cell to enter the note. The title bar in the Notes area shows 
you which cell is being edited.

2. Type the note in the Notes area. Remember that notes are specific to 
the spreadsheet being viewed.

Entering Notes for Students or Classes

1. From the Setup menu, select Students or Classes.

2. Select the Notes tab.

3. The Notes tab records your comments. You can keep separate notes 
for each spreadsheet.
If you have chosen to show “All Students”, the Notes tab appears 
dimmed.
A small red marker in the lower-right corner of the cell on the 
spreadsheet indicates that notes exist for that student or class.
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Finding Text in Spreadsheets and Notes

The Find command searches for a word or phrase in the spreadsheet and 
the notes behind it for tasks, students, and classes. It searches the current 
spreadsheet, and if the text is not found, you can choose to search other 
spreadsheets.

1. From the Edit menu, select Find.

2. Type the characters you want to find.

3. If you want to search only for complete words, select Whole Words 
Only. In that case, a search for “bat” would skip over “batch”.

4. If you want to search the notes, select Search Notes.

5. If you want to search the surface of the spreadsheet, select Search 
Spreadsheet Cells.

6. Click Find.

When the text is found, it is highlighted.To search other spreadsheets in 
this gradebook, select that spreadsheet in the viewer.

If you want to repeat your search, use the Find Again command.
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Shortcut

Both the Find and the Find Again commands are available on the context 
menu that displays when you right-click (Windows) or Ctrl-click 
(Macintosh) a word in a note.

Checking Your Spelling

InteGrade Pro student information software can check your spelling as you 
are typing a note for tasks, students, or classes.

Configuring the Spell Checker

You can customize the spell checker of InteGrade Pro student information 
software.

1. From the Setup menu, select Display and click the Spelling tab.

2. Select your spelling options:

l Always check spelling controls when your spelling is checked. If it is 
checked, the spell checker is always on. If it is not checked, you 
have to choose Next Spelling Error from the Edit menu to activate 
spell checking.

l Ignore words in all caps makes the spell checker skip words, like 
SAT, that are in capital letters.

l Ignore words containing numbers makes the spell checker skip 
words, like 4th, that contain numbers.

3. Review the list of ignored words. You add words to this list during spell 
checking when you select Ignore Word from the context menu. 
Select a word and click Remove to remove it from the list, or click 
Remove All to clear the list.

4. Select how many suggestions you want to see in the context menu by 
sliding the control between Fewer Suggestions and More Suggestions.
Setting the slider to the far right will offer many suggestions, some of 
which may be inappropriate. Setting the slider to the far left will offer 
fewer suggestions, but is less likely to provide the correct suggestion 
for some words.
Set the slider somewhere in the middle at first. You can always change 
it later to suit your working preferences.
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5. Select the dictionary you want to use. 
This product ships with five dictionaries: American English, British 
English, French Canadian, French, and Spanish. The dictionaries 
display in alphabetical order in the drop-down list.

6. Click Close.

Correcting a Misspelled Word

If you have set up Always Check Spelling, as you type, the misspelled 
word in your note appears underlined.

1. Bring up the context menu.
Right-click in Windows, or Control-click on a Macintosh to display that 
context menu.

2. The context menu displays a list of suggestions. 

l Select one of the words to replace the misspelled word.
l If you know the word is spelled correctly, select Ignore Word.
l Or, if you choose to keep the spelling of this word, select Add to 

Dictionary.

Starting the Spell Checker

If you have not configured the spell checker to always check spelling, you 
can still start this process in one of two ways:

l From the Edit menu, select Next Spelling Error.

or

l Click a correctly spelled word to bring up the context menu (right-click in 
Windows or Control-click on a Macintosh) and select Next Spelling 
Error.

This command searches for the next incorrectly spelled word in this note 
and moves on to subsequent notes.

Using a Dictionary or Thesaurus

Selecting Dictionary.com opens a public access dictionary, if the computer 
has Internet access.
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Working With 
Attendance and 
Seating Charts
InteGrade Pro student information software can help you track attendance 
in two ways--with its Attendance spreadsheet and with the feature on the 
seating chart that lets you take attendance. 

About the Attendance Spreadsheet
In an Attendance spreadsheet, calendar days replace the task columns. 
Attendance spreadsheets may be automatically created by import from 
your office administration system. They may also be created manually. 
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If the Attendance spreadsheet was manually created, you can switch the 
calendar days on or off. For example, you can turn on attendance days 
and turn off weekends and holidays. The columns for inactive days are 
gray. Calendar days on Attendance spreadsheets created by import from 
your office administration system cannot be turned on or off. 

Determining Your Attendance Spreadsheets Needs

Consider the following when creating an attendance spreadsheet:

l Do you frequently refer to attendance records? If you use a single 
spreadsheet, it can require extensive scrolling.

l How do you organize your other spreadsheets—by semester or 
reporting period? You can organize your attendance the same way.

l When do you take attendance? If it is twice a day, you should create at 
least two spreadsheets, because each spreadsheet records one 
attendance activity per student, per day.

Creating Attendance Spreadsheets

1. From the Setup menu, select Spreadsheet. 

2. Click New.

3. Select Create an Attendance Spreadsheet and click Next.

4. Enter a name for your spreadsheet and enter a start and end date.

5. Click Create.
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6. Click Close.
Your new spreadsheet is available from the Spreadsheet drop-down 
list on the class viewer.

Entering Attendance

1. Select the appropriate Attendance spreadsheet from the class drop-
down list.

2. Ensure that the current school day is active. If you have a manually 
created spreadsheet, look for the checkbox in the column heading.

3. If a student is present, no action is necessary.

4. If a student is late or absent, enter the appropriate attendance code for 
students, either by typing in the code, or by using the drop-down list. 
Right-click the cell (Windows) or Ctrl-Click (Macintosh) and select the 
code from the context menu.
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5. Optionally, open the Notes area and enter comments about the 
attendance activity. For example, you can record the student’s excuse, 
or note that an absence was due to a field trip.

Printing Attendance Spreadsheets

1. Select the appropriate Attendance spreadsheet from the drop-down 
list.

2. From the File menu, select Print. 

3. From the Print dialog box, select Spreadsheet Report. Click OK.

4. From the Spreadsheet Report dialog box, make any necessary 
changes then click Next. A preview of the report displays. Click Print.

The Spreadsheet Report may also be accessed from the Reports menu.

About Seating Charts
The seating chart shows you where each student should be sitting. You 
can also choose to display student pictures, zoom in and out, display 
names and other information about your students, and move students 
between desks using a drag-and-drop operation. 

The seating chart can be used with any class in the gradebook, and you 
can select any spreadsheet in a selected class. If you display a Numeric, 
Skill, or EndTerm spreadsheet the desk icons display task scores. If you 
display an Attendance spreadsheet, the desk icons display attendance 
codes for the selected date and student. 

Note: Removing a student from the seating chart does not affect the 
student’s enrollment in the class.

Creating a Seating Chart

There are two ways to create a seating chart. You can use the seating 
chart wizard that displays the first time you select Seating Chart from the 
Show drop-down list. You can also select the New Seating Chart option 
from the View menu. 
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For the First Time

1. The very first time you select Seating Chart from the Show drop-down 
list, the New Seating Chart dialog box displays. 

2. Enter the necessary information in each of the dialog boxes. 

3. Click Create in the last dialog box to create your seating chart. The 
seating chart is in Layout Mode at the end of this process.

As a Replacement

1. From the Show drop-down list in the viewer, select Seating Chart.

2. From the View menu, select New Seating Chart.

3. Because only one seating chart can be created per class, a warning 
message displays asking if you want to delete the current seating 
chart.

4. Click Yes to continue with the process and replace the current seating 
chart.

5. Enter the number of rows, and the number of desks in each row, then 
click Next.
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6. Snapping to the grid helps you align the desks neatly on screen. If you 
must change the default settings, do so, then click Next.

7. If you want the system to assign your students a spot in the seating 
chart, select Assign Students to Desks, then choose a method, either 
the order they appear in the gradebook, or random order.
If you want to assign students to desks yourself, deselect Assign 
Students to Desks. 

8. Click Create.
The seating chart is in Layout Mode at the end of this process

The Two Modes of Working With a Seating Chart

There are two modes for seating charts: Layout and Update. Layout mode 
is used to define the physical layout of the seating chart or assign students 
to desks. 

You are in Layout mode when the Layout Tool floating window is available 
and grid lines display on the seating chart. Update Mode is used to edit 
student scores and attendance in the seating chart.
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You can switch between the modes by choosing Show/Hide Layout Tools 
from the View menu.

Using the Layout Tool

Use the Layout Tool to edit the layout and desk assignments in the seating 
chart.

1. From the View menu, select Show Layout Tools.

2. The Layout Tool screen displays with a list of students in the selected 
class. The names of students with assigned desks display beside a 
desk icon. Students who are displayed as standing do not have an 
assigned desk.

3. To place an unassigned student into a desk, drag the standing student 
icon and drop it onto the grid. The student’s name, and picture—if 
used—displays on a new desk icon.

4. To add empty desks or a teacher desk to your seating chart, drag the 
empty desk or teacher desk icon onto the grid. The teacher desk 
includes a field for the teacher name. Editing this field does not change 
the teacher name stored in the gradebook.

5. To switch two students, drag one picture or desk over another.

6. To remove a student from the seating chart, highlight the desk and 
click Delete, or right-click the desk and select Remove Student From 
Desk or Remove Desk.

7. To hide the layout tools, from the View menu, select HIde Layout Tools.
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Show/Hide Student Pictures

You can choose to show student pictures in the seating chart. These 
pictures are imported from CD-ROMs prepared for the school by a 
photography studio. (Macintosh computers require Apple QuickTime 
version 3.0 or later.)

l From the View menu, select Show Student Pictures.

To hide them, from the View menu, select HIde Student PIctures.

Zoom In and Out

While in Update Mode you can zoom in and out to get a closer look at the 
seating chart and the photos.

1. From the View menu select Zoom to 150% or Zoom to 200%. 

2. Select Zoom to 100% to return to the default setting.

3. You can also use the magnifying glass icons on the horizontal scroll 
bar beneath the Seating Chart.

Resetting Grid Options

You can change the spacing between pictures.

1. From the View menu, select Grid Options.

2. Select the spacing you want between pictures.

3. Optionally, choose to snap to the underlying grid.

4. Click OK.

Taking Attendance From a Seating Chart

1. You must be in Update mode to take attendance from a seating chart. 
Check the View menu, and if necessary, select Hide Layout Tools.

2. Select an Attendance spreadsheet.

3. If a student is present, no action is necessary.
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4. If a student is late or absent, enter the appropriate attendance code for 
students, either by typing in the code, or by using the drop-down list. 
Right-click the cell (Windows) or Ctrl-Click (Macintosh) and select the 
code from the context menu.

Recording in Many Cells at Once

You can quickly fill the cells with an attendance code.

1. Right-click the cell (Windows) or Ctrl-Click (Macintosh) and select Fill 
Chart.

2. Enter the absence code you want to replace all cells with.

3. If you prefer, select Replace only Empty scores to leave existing codes 
untouched.

4. Click OK.

Managing Student Pictures
If you have student pictures in digital format, you can see them in the 
seating chart view and in the Students dialog box available from the Setup 
menu. Pictures are especially useful for substitute teachers taking class 
attendance. 

For Windows, the pictures must be in .jpg or .bmp format. The Macintosh 
platform supports those two formats, as well as many other formats 
including .pict, .giff, and any other file that can be read by Quicktime 3.0. 

1. From whatever source you have obtained them, move the picture files 
to the Pictures folder in the InteGrade Pro folder on your hard drive.

2. Use a text editor (Notepad in Windows or SimpleText in Macintosh) to 
create a text file named xrefpict.txt and save it in the Pictures folder 
where the pictures are stored. This file is used by the system to link 
each student to their picture.

Each line of the file contains a student number in quote marks, and the 
filename of their picture in quote marks. The information is separated 
by a comma.

For example, the contents of the xrefpict.txt file might look like this for 
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students 3401, 3402, and 3403:

"3401","517.BMP"
"3402","667.BMP"
“3403”,”534.BMP”

If every student does not have a picture, no error messages are 
created. You will not see a picture of that student.

Exporting Daily Attendance 
If you set up your gradebook by importing data from your administration 
system, you can export daily attendance results. You can do this while in 
an attendance spreadsheet or while using the seating chart. If you did not 
import data from your administration system, you cannot export data back, 
and this procedure will not work.

Attendance data is exported as an AXxxxxxx.GRD file and is exported to 
your teacher folder or wherever your CL files are located. Your 
administration system can then import this file to record daily attendance. 
This feature is implemented for TSS, Osiris, CIMS, and SASI III. The 
SASIxp product uses the Classroom module to report attendance. 

From an Attendance Spreadsheet

1. From an attendance spreadsheet, click the column containing the data 
you want to export. You can also right-click any cell in the column.

2. From the drop-down list, select Export This Day’s Attendance.

3. A message displays asking if you want to proceed with the export. 
Click Yes.

4. A progress bar displays indicating that the attendance data has been 
exported.
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From a Seating Chart

1. If you are taking attendance from a seating chart, right-click a student’s 
desk and select Export This Day’s Attendance from the drop-down list.

2. A message displays asking if you want to proceed with the export. 
Click Yes.

3. A progress bar displays indicating that the attendance data has been 
exported.
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Creating Reports and 
Graphs
InteGrade Pro student information software provides a dozen reports and 
three graphs you can use to analyze the performance of your students and 
review the effectiveness of your tasks.

You can also mail a progress report to a parent’s home or office.
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Working With Reports
This is an overview of creating a report. Details of each report appear on 
the following pages.

1. Select one of the following reports from the Reports menu. 

l Mail Progress Report
l Class Attendance
l Class Roster
l Missing Tasks
l Multi-Class
l Seating Chart
l Spreadsheet
l Student Attendance
l Student Demographics
l Student Progress
l Student Rank
l Task Details

2. Select the specific content you want to see on the report.

3. Click Next.

4. Click Print.

Selecting Students and Tasks

Besides selecting and deselecting students and tasks by clicking, here are 
some other ways to accomplish this:

l To select all or nearly all the students or tasks, click All, then deselect 
the ones you don’t want included.

l To select only a few students or tasks, click None to clear the list, then 
select the items as necessary.

l To select using the keyboard, use the Up and Down arrow keys to move 
the cursor, and the space bar to toggle the selection of an item. (Not 
available on Macintosh systems.)

l To select students based on certain criteria, click Filter.

Note: The task information displayed on the report depends on the 
auxiliary fields displayed. For example, if you select Due Date in the main 
viewer, that information shows in the Spreadsheet and other reports that 
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display task infomation. If you select Skill Type for that column, that 
information displays. See “Customizing Spreadsheet Columns” on 
page 52.

Using Filters

Filters offer a powerful method of automatically selecting students or tasks 
based on criteria that you specify. The following are some examples of 
how filters can help you:

l Many schools require teachers to send interim reports home for stu-
dents “at risk of failing.” The filters can help you precisely target such 
students. Conversely, the filters can help you identify those students 
who are doing well for additional praise.

l If you have made note of the teams and clubs in which your students 
participate, you can use the filters to locate the band members who 
were on tour for two weeks. You can also print a list of the tasks they 
missed.

You can manually exclude students or tasks in the list returned by the 
filters. However, if you reapply the filter, the manually excluded lines are 
included again.

1. Click the Filter button below the Students or Tasks area.
You can create and use a filter for students or for tasks, or for both 
students and tasks.

2. Select Show Students Whose or Show Tasks Whose.

3. Select the filter you want to use, and modify it using the drop-down 
lists.
For example, if you want to see only the students who were away with 
the flu, and if you had put the word “flu” in their student score note, 
select Student score note contains and type the word flu.
Or if you want to see the tasks that are due on a certain date, select 
Due Date and use the drop-down lists to complete the expression.

4. Click OK.

Note: Filters are stored during a session. For example, if you use the 
Student Filter in the Class Roster report, the filtered students appear in the 
other reports as well. To not use a filter that you have created in a session, 
click Filter and select Show All Students.
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Email Progress Report

You now have the ability to email a progress report to parents or 
guardians. Before you can email the reports, you must be sure that your 
email connection is set up, and that you have an email address entered in 
the Student dialog box for each recipient of this report.

Note for Macintosh users: The Email Progress Report is not available on 
68K Macintoshes. It is available on the Power PC models only if you are 
running System 9.0 or later.

Setting Up Email Communications

If you electronically imported your data, some of this data may already be 
entered. 

1. From the Setup menu, select Communication.

2. On the ID tab, if you did not import your data, you may need to 
complete the Teacher Name field.

3. Consult your system administrator for the information related to your 
school’s email system.

4. Click Close.
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Entering Recipients’ Email Addresses

1. From the Setup menu, select Students, then the Contacts tab.

2. Select a student.

3. From the Contact Type drop-down list, select the contact for this 
student who will receive this report.

4. Enter their email address.

5. Select Send email reports to this contact.

Creating the Email Progress Report

For each student, you can prepare and email a report detailing their tasks 
and scores received.

Reports are sent only to those people with email addresses, even though 
all the students appear in the list. Select the dates this report covers, as 
well as the tasks. You can choose to include an attendance summary, the 
class average, and any of your notes.
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On the Preview screen, use the scroll bar across the top to see each 
individual report. Check each student’s name at the left. If an email 
address appears in angle brackets <like this> beside the student name, 
the report will be sent. If no name appears, the report will not be sent. You 
can resize the window at the left listing the student name.

Sample Email Progress Report
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Class Attendance

This report displays a class list with the totals of various absences and late 
activity for the specified dates. This summary uses the system codes as 
defined in “Setting Up Attendance Codes” on page 34.

Enter the start and end dates that this report covers, and decide whether 
you want a summary and a legend. If you select Attendance Register, you 
get the detail of each day or a total of Late and Excused.

Sample Class Attendance Report.
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Class Roster

This report creates a class list with fill-in blanks beside each student name. 
It creates an all-purpose form you can use to record everything from 
attendance and task scores to locker assignments and lunch money.

Select how you want your class roster to look. You can choose a large fill-
in blank beside each student name, or select vertical lines with or without 
title spaces, depending on what you want to record. The Tall Rows option 
leaves you plenty of room to write on the roster.

Sample Class Roster Report.
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Missing Tasks

This report identifies those tasks in which a student received a 0.0, 
Excused, or an Incomplete score.

Decide whether you want this report printed with one student per page, 
possibly with a line for a parent’s signature, or if you want a report listing all 
the students on one page. You can also select what kind of scores to 
include in the report.

Note: The options for this report are different if you are using a Skill 
spreadsheet.

Sample Missing Tasks Report.
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Multi-Class

This report creates a list of all scores by spreadsheet (numeric and skill) 
for each student for all classes. By printing this report you can see at a 
glance how well each student is doing in each class.

Select which students and which classes you want included in the report, 
as well as the date range and notes to include.

Sample Multi-Class Report
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Seating Chart

1. Select a class.

2. From the Reports menu, select Seating Chart.
The seating chart for that class displays on screen.
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Spreadsheet

This report displays the contents of the active spreadsheet. It serves 
multiple purposes depending on which spreadsheet is active.

Note: The options for this report are different, depending on the 
spreadsheet you are using. 

l If a Numeric or Skill spreadsheet is active, the Spreadsheet report 
shows how the students are doing on the tasks.

l If an Attendance spreadsheet is active, the Spreadsheet report shows 
the attendance activity over a specific date range.

l If the EndTerm spreadsheet is active, the Spreadsheet report prints the 
contents of the EndTerm spreadshee.

Sample Spreadsheet Report.
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Student Attendance

This report displays a class list with the totals of various absences and late 
activity for the specified dates. This summary uses the system codes as 
defined in “Setting Up Attendance Codes” on page 34.

Enter the start and end dates that this report covers, and decide whether 
you want a summary and places for signatures.

Sample Student Attendance Report
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Student Demographics

This report displays demographic information for students. Use it to verify 
the accuracy of the information entered and to print a permanent record of 
student information.

You can choose between two layouts: single line or multiple lines. Use 
single line if you are printing only a few demographic fields. Use multiple 
lines if you are printing many fields. 

Sample Student Demographics Report
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Student Progress

This report shows the student’s score and class average for each task. It 
also shows missing tasks and a grades analysis graph. You can use it as 
an interim or informal report card.

Select the students and the tasks that you want included, along with the 
date range. Select the other details that you want included in the report. 

Sample Student Progress Report
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Student Rank

This report ranks each student by how well they did on a particular task.

Select which students and which tasks you want included, and what kind 
of marks to include.

.Sample Student Rank Report
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Task Details

This report prints the information recorded in the Edit Tasks dialog. Use it 
to verify that the tasks you entered are correct.

Select the tasks to include and choose how much detail to show.

Sample Task Details Report 
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Working With Graphs
This is an overview of creating a graph. Details of each graph appear on 
the following pages.

1. Select one of the following graphs from the Graphs menu. 
You may also use the shortcuts on the toolbar.

l Student Performance
l Task Comparison
l Task Correlation

2. Select the specific content and style you want to see on the graph.

3. Click Print.
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Student Performancez

This graph analyzes a student’s performance on each task, using one of 
six different Graph Styles: 

l Earned Percent
l Ink Blot
l Score Bar
l Whisker
l Line
l Whisker & Blot

Select a Student. Optionally, select an Envelope of standard deviation, and 
the class average. 

Click the colored blocks next to Score and Average to change the display 
color.

Click the button at the far right, under the Help button, to change the 
orientation of this report.
Copyright © 2000 National Computer Systems, Inc. Working With Graphs  135

http://k12.ncs.com/


Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
Task Comparison

This graph compares two tasks and displays the number of students with 
letter grades and/or percentage intervals for each task. It lets you view, at 
a glance, the relative difficulty of one task as compared to another and the 
approximate score distribution.

Select a graph styles from:

l Area
l Area 3D
l Covered bar
l Covered bar 3D
l Line, Line 3D
l Side Bar
l Side Bar 3D

Choose two tasks, and the interval. Interval refers to the number of 
intervals on the X-axis. For example, an interval of 10 means the score 
ranges will be 0%, 10%, 20%, and so on.

Click the colored blocks next to Task 1 and Task 2 to change the display 
color.

Click the first button at the far right, under the Help button, to change the 
ordering of the report (Task 1 followed by Task 2 instead of Task 2 followed 
by Task 1). Check the second button at the far right to change the 
orientation of the report.

.
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Task Correlation

This graph compares any two tasks and shows the correlation of scores 
between the two. A high correlation means the class as a whole fared 
similarly on the two tasks.

Select the two tasks from the drop-down lists.

Click the colored block next to Ink Blot to change the color of the graph.
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Setting Up Reports and Graphs
Any change you make to one report applies to all reports printed after that, 
until you change these settings again.

1. From the Reports menu, select Report Setup. 
You can also click Setup on any report or graph dialog box.

2. In the Report Title field, type a report title. This title prints on all reports, 
so be sure the title is appropriate for any report and all classes.

3. In the Margins fields, the default report margin is 0.5 inches. If you 
need to three-hole punch the reports, set the left margin to 1 inch.

4. In the Identify Students By field, the default is to identify by student 
name and the demographic field currently showing in the spreadsheet. 

If you want to publicly post a report, you can suppress the student 
name and use a “scramble” sort on the spreadsheet to ensure greater 
confidentiality. You can also choose to print a demographic field that is 
not currently showing, or completely suppress the printing of additional 
demographics.

5. In the Font and Size field, you can change the way the report prints. 
The Windows version defaults to Arial 9 point; the Macintosh defaults 
to Geneva 9 point. If you change the font or size, it becomes the new 
default and applies to all reports.

Caution Be careful when choosing a larger font size. You could be 
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changing the layout of the report if text that is made larger spills over 
into a second line. Check the report preview carefully. 

If you move a gradebook to or from a Windows or Macintosh system, 
check the Font and Size settings before printing because the default 
font and size may not be what you expect.

Previewing Reports 
All the reports automatically preview on-screen before they print. This 
enables you to check the effects of the parameters or the setup before 
printing. 

1. Click Next on a report request dialog to display the preview.

2. Click Print to continue with printing or click Cancel to close the window.

3. To adjust the parameters, click Setup. This returns you to the report 
request dialog box, without closing the preview.

4. After changing some settings, click Next to see how the new 
parameters affect the preview. 

Using the preview is slightly different, depending on the platform.

Windows Version

In Windows, the preview initially shows the entire page.

1. Click anywhere within the page to magnify the preview.

2. Click again to return to the full page view.

3. You can also click the right mouse button and select either Zoom In or 
Zoom Out.

4. To print a single page of the report, click the right mouse button and 
select Print this Page.

A horizontal scroll bar displays above the preview area if there are multiple 
pages in the report. Use this bar to page through the report. You can also 
click the right mouse button and select Next Page or Previous Page.
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To see the portions of the report that are out of view, use the scroll bars, or 
hold down the <CTRL> key and drag the mouse.

Macintosh Version

In the Macintosh version, the preview shows the entire page. Click 
anywhere within the page to magnify the preview. Use the horizontal and 
vertical scroll bars to move the window of view.

A horizontal scroll bar displays above the preview area if there are multiple 
pages in the report. Use this bar to page through the report, or use 
Command-N to page forward or Command-B to page backwards. You can 
also use the following mouse shortcuts:

1. Click and hold the mouse button to display a pop-up menu. 

2. To move through multiple pages, click and hold the mouse button and 
select Next Page or Previous Page.

3. To print a single page of the report, click and hold the mouse button 
and select Print This Page.

Previewing Graphs
All the graphs automatically preview on-screen before they print. This 
enables you to check the effects of the setup before printing.

After you have made any changes, click Print to continue with printing or 
click Cancel to close the window. 

Using the preview is slightly different, depending on the platform.

Windows Version

In the Windows version, the preview shows the page in a reduced size.

1. To enlarge the size of the viewing area, click the right mouse button to 
display a pop-up menu and select Zoom In. To return to the original 
size, click the right mouse button and select Zoom Out.

2. To move through multiple pages, click the right mouse button and 
select Next Page or Previous Page.
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3. To print a single page of the graph, click the right mouse button and 
select Print This Page.

If an item on the pop-up menu appears dimmed, it is not available in this 
preview. To see the portions of the graph that are out of view, use the scroll 
bars, or hold down the left mouse button and drag the mouse.

Macintosh Version

In the Macintosh version, the preview shows the page in a reduced size. 
Click the mouse button to magnify the preview. You can also click the 
preview to zoom in or out. To return to the original size, click the mouse 
button and select Zoom Out.

If an item on the pop-up menu appears dimmed, it is not available in this 
preview. To see the portions of the graph that are out of view, use the scroll 
bars, or hold down the mouse button and drag the mouse.
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Finishing Up the 
Reporting Period
Depending on how your school and district are set up, at the end of each 
reporting period, you may need to export or “send” data to the school 
administration computer to collate grades and print report cards. This 
chapter shows you how to export data using the EndTerm spreadsheet.

If your school does not use an administration system or if you did not 
import your data at the start of the reporting period, you cannot export your 
data from InteGrade Pro student information software. In that case, you 
may want to print a Spreadsheet Report as a record.
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Preparing the EndTerm Spreadsheet
The EndTerm spreadsheet holds the marks and comments exported to the 
administration system. The system automatically creates the EndTerm 
spreadsheet when you import data from the administration system at the 
beginning of the reporting period. 

Check with your system administrator to find out what specific format your 
school uses for this spreadsheet.

During the export process to SASIxp, SASI III, CIMS Student, TSS v8.0, 
and Osiris v5.0, the term as indicated by the name of the EndTerm 
spreadsheet, displays with the collection date. For example, 9/4/1998:1st 
Progress Report. 

Excluding Unnecessary Tasks

Towards the end of a reporting period, your class file could contain tasks 
you do not want included in the calculations until the next term. Do not 
delete these tasks. Instead, use one of these two methods:

l From the Setup menu, on the Grading Rules dialog box, define a task 
type called Not Used and set it to contribute 0% towards the final grade.

Change all tasks that you want to exclude from the calculations to this 
type before using the EndTerm spreadsheet.

OR

l Create a new spreadsheet called Unused or Next Term.

Copy all the relevant tasks to this spreadsheet and delete them from 
the current spreadsheet.

Entering Comments

Comments are the short phrases used on report cards to describe the 
progress of a student.
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1. Import the COMMENTS.TXT file into InteGrade Pro student 
information software. Importing stores the comments in the gradebook. 
Check with your System Administrator. This step may have been done 
at the beginning of the year.

2. Open the EndTerm spreadsheet and select the appropriate cell in the 
Comment #1 column.

3. Enter the comment in one of three ways:

l Use the Comment drop-down list above the spreadsheet. This list is 
available only if you imported comments. 

l If you know the comment number, enter it directly into the 
spreadsheet cell.

l Right-click the cell (Windows) or Ctrl-click (Macintosh) and select 
the comment from the context menu. The text for the comment 
displays in the drop-down list for your verification.

4. To enter more comments, use the two adjoining comment columns.
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Entering Comments Without a Comments.txt File

1. Ensure that you have a list of comments to use. Each comment must 
have a number.

2. Enter the comment numbers into the appropriate comment columns.

Entering Attendance Summaries

A report card needs a summary of attendance. Copy the attendance into 
this EndTerm spreadsheet.

1. Click the column title of All Absences or All Tardy.

2. Select Replace Task from the drop-down menu.

3. Select the class and Attendance spreadsheet from which to copy 
attendance totals. Click Next.
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4. Select the Attendance Summary from the list of items to copy (the first 
item on the list). Click Next. 

5. Select which attendance codes to total into the summary. Click Next.
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6. Select a date range for which to calculate attendance summaries. Click 
Next.

7. Click OK to continue. The attendance totals copied from the 
attendance spreadsheet fill the column.

You could use the Copy Tasks command from the Tasks Menu to obtain 
similar results. 

Entering Final Grades

1. Click the title of the appropriate EndTerm spreadsheet column to 
display a drop-down list.

2. Select Replace Task from the drop-down menu.
148  Preparing the EndTerm Spreadsheet Copyright © 2000 National Computer Systems, Inc.

http://k12.ncs.com/


Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
3. Select the class and spreadsheet from which to copy scores and click 
Next.

4. Specify the information to copy. The choices are:

l Summary grade—The students’ overall grades in the spreadsheet.

l Type total—The students’ performance over a specific task type. 

l Task score—The students’ performance on a specific task. 
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5. Indicate how the EndTerm spreadsheet should display the grades. It is 
important that the scores be displayed in a format expected by the 
administrative system. For example, does your school use letter grade 
or percentage.

6. Click OK to continue. 
The grades copied from the main spreadsheet fill the column. 
You can edit the copied data on a cell-by-cell basis if needed.

Working With the EndTerm Spreadsheet

Clearing A Column

Use this procedure when you need to clear an entire column. You cannot 
erase the student name and demographic columns.

1. Click the heading of the column to erase. 

2. Select Fill Column from the drop-down list.

3. Do not enter a New Score. 

4. Click Fill.

5. Click Yes to confirm that you want to replace the scores with blanks.
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Sorting On a Column

Use this procedure to reorder the EndTerm spreadsheet for your own 
informational purposes. Sorting the spreadsheet does not affect the order 
in which student records are exported. 

1. Click any column heading.

2. Select Sort Students by Column or Sort Students. 

Printing the EndTerm Spreadsheet

To print the EndTerm spreadsheet, print the Spreadsheet report while the 
ETS is active in the class viewer. 

You should print the ETS to verify the entries in the EndTerm spreadsheet 
before submitting data to the office. 

If you are not electronically submitting data at the end of the reporting 
period, the data in this Spreadsheet report contains enough information to 
create report cards by hand.

Exporting Data
After creating and verifying the EndTerm spreadsheet, the next step is to 
send the information back to the office. However, you are not really 
sending the EndTerm spreadsheet or the EndTerm report. Rather, the 
EndTerm spreadsheet contains summarized information in an export file 
and that file is sent to the office. 

Caution In a Windows environment, before you can export when using 
Novell and other servers, you must map the drive to which you want to 
export. To map drives in Windows, right-click on the My Computer icon 
and select Map Network Drive. Select a drive letter (e.g. X:\ ) from the 
Drive drop-down list. Enter the complete network drive name in the Path 
field (for example, \\myserver\sharedfolder). Select Reconnect at Logon so 
that you do not have to repeat this procedure every time you log on.

Requirements

To ensure a successful export, check the following for each class 
exported:

l Every student has the correct student number.
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l Every class has a course and section number; some classes may 
require a Subject ID (check with your system administrator). Check the 
Advanced Fields on the ID tab, located under Classes in the Setup 
menu for this information.

l You have several blank, formatted disks if exporting using disks.

Exporting data

1. From the File menu, select Export from Gradebook.

2. Follow the prompts in the dialog boxes to save to the teacher folder 
corresponding to your teacher number. 

3. Take the exported file from the specified location and deliver it to the 
main office.

Delivering the File

After creating the export file, deliver it to the school office. The school 
produces report cards by combining export files from all teachers in a 
school.

There are several ways to submit the export file. Your system 
administrator will tell you about the procedures at your school. The 
following are some common methods:

l Copy the export file to a specific directory on the network.

l Submit the export file on a disk.

l Send the export file using e-mail.

After sending the export file to the office, make another copy of the export 
file on a disk and archive it. As an additional safeguard, keep the export 
file on your hard disk until the report cards have been printed. It is not 
necessary to delete the file when you create an export file at the end of the 
next reporting period. Your hard disk automatically overwrites the export 
file.

Archiving Your Gradebooks
It is good practice to archive your gradebooks at the end of a reporting 
period. 
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Preparing Gradebooks for Archiving

1. If you have used a password, remove the password from the 
gradebook. You may need the gradebook for future reference and may 
not remember the password. Or, other school personnel may need 
access to your files. See “Using Passwords” on page 42.

2. Lock the scores on the spreadsheets. This prevents the scores from 
being accidentally modified or deleted. See “Locking and Unlocking 
Scores” on page 44.

3. Optionally, use your operating system to change the file properties to 
“read only”, to prevent accidental changes to the file.

Printing Archive Reports

Along with archiving the class files electronically, it is equally important that 
you retain archives in paper form. This provides an additional safeguard in 
case the electronic backups fail.

The two reports essential for archiving are the Spreadsheet Report and 
the Student Progress Reports. Together, they show all information for a 
class file.

Remember to print these reports for each spreadsheet that you use. See 
“Spreadsheet” on page 128 and “Student Progress” on page 131.

Backing up the Gradebook 
After removing the passwords, save your gradebook file on a blank, 
formatted disk. Leave the original file on the hard disk.

You should also retain the installation disks for the product. Future 
versions of the software can always read the files from the version 
immediately previous, but there is no guarantee that they will be able to 
read class files that are several versions back.

In Windows, the gradebook files have a “GBF” ending. The Macintosh 
uses a unique icon to indicate the gradebook files. By default, the product 
stores the gradebook files in the same directory as the InteGrade Pro files.

For instructions on copying files, see the user manual that came with your 
computer.
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Store all backups, along with a set of the InteGrade Pro installation disks 
and the archive reports, in a safe place for future reference. 
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Index
Symbols
.BMP 113
.GBF 27, 40, 153
.GIFF 113
.JPG 113
.PICT 113

A
ABACUSxp 30
Administration System 32
Advanced Fields 152

caution about changing 41
Archiving 153

lock scores before 153
Attendance

class report 123
codes 34
creating spreadsheet 106
determining recording needs 105
entering in spreadsheet 107
entering summaries 146
exporting daily 114
in EndTerm spreadsheet 7
notes 108
printing spreadsheet report 108
quick fill in seating chart 113
student report 129
table of system codes 34
take from Seating Chart 112

Attendance spreadsheet 6, 105, 106
customize 53

Authorization of the product 22
Automatic updates 32
Auxiliary column 8, 9, 54

B
Back-up 152, 153
Backup file 12
Bulk fill 82

C
Caution

changing font size in reports 139
in dropping score 92
mapped drive requirement in Win-

dows export 151
CIMS 30, 31, 114, 144
Class 3

creating 63
delete student 59
deleting 64
multi class report 126
roster report 124

Class Attendance report 123
Class roster file 6, 11, 12, 25, 26, 29, 33
Class Roster report 124
Class viewer. See Viewer
Classes 57

adding manually 41
adding students 64, 65
importing 29
inactivating students in 66
modifying data 62
notes 101
removing students 66
removing students from 66
viewing data 62

Column
auxiliary 8
filling 85
setting width 51

Comments 4
add to EndTerm 144
entering with a file 145
entering without a file 146
importing 29

comments.txt 7
Context menu 9, 104

example of 10
Corner clips 51, 58, 79, 99, 101
Ctrl-click 9
Curve scores 96
Customization

columns 57
field titles 56

D
Data 39
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entering manually 40
exporting 151
importing 29
mandatory student 55
preferred method of entry 39
review imported 31

Date settings 50
Decimal points displayed 37
Dictionary 104
Display

change color 51
date settings 50
number of decimal points 37

Drive letter 18, 21
mapped 33

Drop score 93
caution 92

E
Educational Structures 2
Email

address 56
setting up communications 120

Email Progress report 120
EndTerm spreadsheet 6, 47, 144

attendance 7
clearing a column 150
customize 53
entering attendance 146
entering comments 145
entering final grades 148
erasing columns 150
printing 151
sorting 151
sorting on a column 151

Error messages
when importing 33

ETS. See EndTerm spreadsheet
Export

daily attendance 114
data from gradebook 152
from seating chart 115
mapped drive in Windows caution 151
overview 151

Extra fields 50

F
Fields

customize titles 56
extra 50

File
.BAK extension 12
.GRD extension 12
ABxxxxxx.GRD 12
ATxxxxxx.GRD 12
AXxxxxxx.GRD 114
backup 12
BAK 12
class roster 6, 11, 12, 26, 29, 33
CLxxxxxx 26
CLxxxxxx.GRD 11, 33
comments.txt 7, 145
export 152
GBF extension 12, 27, 40, 153
gradebook 12
IGPADMIN.PDF 15
marks data 11
MKxxxxxx.GRD 11
naming conventions 11
naming standards 12
sample data 23
SAMPLE.GBF 24
SETUP.EXE 18
xrefpict.txt 113

Filter 119
examples of use 119
in a report 118
stored in session 119
with Bulk Fill 83, 84
with Drop/Restore 94

Find
repeat 102
shortcut 103
text 102

Fonts in reports 139
Foreign File Access 20

G
Grade table 36

create by copying 36
create new 36
rename 36
sort 37

Gradebook 7
archiving 152, 153
automatic update 32
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backing up 153
closing 9, 27
create by importing 25
creating blank 39
creating manually 39
delete student 59
error messages when importing 33
file naming 12
importing 29
locking 43
opening 27
opens class viewer 7
password 27, 40
revert to earlier version 29
saving 28
saving automatically 28
unlocking 44

Grades 3
calculation of 5
exporting 62
final 7, 148
how calculated 87, 88, 89, 90
letter 5

Grading rules. See Grade tables
Graphs

filters 119
overview 134
previewing 141
setup 139
Student Performance 135
Task Comparison 136
Task Correlation 138

H
Help

email 13
online 13
sample data 23
technical support 13
telephone support 13
training 13

I
IGPADMIN.PDF 15
Igpro folder 15
Inactive students 66
INC 38, 77, 96
Installation

authorization prompt 22
demo version 23
Macintosh

on server 20
stand-alone 20
to client from server 22
using disks 21

Windows
on server 18
stand-alone 18
to client from server 19
using disks 18

Installation disks
Macintosh 21
Windows 18

InteGrade Classic 31
InteGrade Link 72
InteGrade Pro

authorizing 22
default spreadsheets 47
Macintosh installation 19
starting the program 23
using earlier versions 30
Web page 14
Windows installation 17

InteGrade Pro Link 62
InteGrade Pro,upgrade note 2
Internet curriculum 2
ISO 9660 File Access 20

L
Layout mode 110
Layout tool 111
Letter grade 36

create new 37
modify 37

M
Macintosh

and Windows compatibility 27, 40
context menus 9
creating installation disks 21
customize columns 54
email report limitations 120
extensions required 20
file name 27
Foreign File Access 20
installation
Copyright © 2000 National Computer Systems, Inc.   Confidential Information Index – 157

http://k12.ncs.com/


Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
on server 20
stand-alone 20

installing from a server 22
installing on a server 20
installing on one computer 20
ISO 9660 File Access 20
no scanning 16, 85
previewing graphs 142
previewing reports 141
QuickTime requirement 112
report differences 140
requirements 20
requirements for pictures 112
sorting spreadsheet information 70, 79
system requirements 20
three ways to install 20
unique icon 153
using Windows files 12

Mapped network drive 18, 33, 151
Marker

notes 99, 101
score over 100% 79

Menus
context 9

Missing Tasks report 125
Multi-Class report 126
Multiple users 18

N
Network server 18

installation 18
installing from 19

Notes 4, 58, 63, 99, 100
attendance 108
check spelling 103
classes 101
creating 101
find text 102
marker 99
students 101
task 74
viewing 100
visual cues 58

Numeric spreadsheet 4
customize 52
entering scores 81
importing 30

O
Osiris 30, 114, 144

P
Password

changing 43
creating 42
deleting 43
gradebook 27, 40
hints for creating 42
hints for using 42
remove before archiving 153

Pictures 108, 113
change spacing between 112
formats 113

Preferences 28

Q
QuickTime 112, 113

R
Random sort 61
Report cards 7
Reports

caution on using larger font 139
Class Attendance 123
Class Roster 124
Email Progress 120
filters 119
Macintosh and email reports 120
Missing Tasks 125
Multi-class 126
overview 118
previewing 140
print for archive 153
Seating Chart 127
setup 139
Spreadsheet 77, 91, 128
Student Attendance 129
Student Demographics 130
Student Progress 131
Student Rank 132
Task Details 133

Requirements
Macintosh 20
Windows 16
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Restoring scores 95
Revert to Saved 29
Right-click 9
Rosters

importing 29

S
SAMPLE.GBF 24
SASI III 30, 114, 144
SASIxp 30, 114, 144
Scale factor 70
Scan forms 16
Scanning 85, 86, 87

not available on Macintosh 85
Windows requirements 16

ScanTools 17
School year

illustration 11
overview of work 10

Scores 3, 4, 57
adjusting 91, 93, 97
curving 96, 97
dropped 92
dropping 93
entering 73, 80, 81
entering bulk 82
entering in spreadsheet 81
entering in Student dialog box 82
filling column in spreadsheet 85
importing 29
incomplete 38
locking 44, 73, 153
pick highest 97, 98, 99
restore dropped 92, 95
scanning 85
special 37
transform while replacing 76
transformations 57
unlocking 45

Scramble sort 61
Search

repeat 102
text 102

Seating chart 108
change spacing between pictures 112
change zoom level 112
creating 108, 109, 110
exporting attendance 115

layout tool 111
modes 110
taking attendance from 112
zoom in and out 112

Seating Chart report 127
Security 42

gradebook password 40
locking gradebook 43
locking scores 44, 73
on posted reports 139
password 27

Server
installing from 19
installing on 18
installing on a Macintosh 22

Set 3
delete 39
rename 39

SETUP.EXE 18
SFWTOOLS 17
Shortcut menus 9
Show drop-down list 8, 100
Skill spreadsheet 5

customize 52
importing 30

Sort
manually 79
order 78
random 79
scramble order 61

Special score 37, 81
create new 38
delete 38
INC 38
modify name 37
modify score 37

Spell checking 103, 104
configuring 103
correcting misspelled words 104

Spreadsheet 4, 47
Attendance 6, 105, 106
attendance on EndTerm 7
change color 51
creating 48
customize columns 52, 54
customizing columns 52
deleting 49
EndTerm 6, 144
erasing columns 150
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Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
find text 102
importing 29
managing 48
notes 101
Numeric 4, 81
renaming 49
set column width 51
Skill 5
sorting EndTerm 151
specify display characteristics 49
Total points 5
weighted 5

Spreadsheet report 77, 91, 128
for archiving 153

Statistics
on task 74

Student
adding contact information 59
adding manually 40
adding to classes 64
assign to desk 111
contact email address 121
deleting 59
deleting from gradebook 55, 62
demographic report 130
gender unknown 55
inactivate 59
inactivating 66
mandatory data 55
manual sort 61
modifying data 55
name preceded by tilde 66
notes 101
performance graph 135
pictures 108, 112, 113
progress report 131
rank 132
removing from class 66
scramble sort 61
selecting for a report 118
sorting 60, 61
viewing data 55

Student Attendance report 129
Student Demographic report 130
Student Performance graph 135
Student Progress report 131

for archiving 153
Student Rank report 132
Students

pictures 113
removing from class 66

Support 13
Syllabus 63
System Administrator 6, 25, 41, 72
System requirements

Macintosh 20
Windows 16

T
Task 3

abbreviated name 71
allow export to InteGrade Link 72
combining 77
comparison graph 136
copy more than one 75
copy one 75
correlation graph 138
creating 70
delete while combining 77
deleting 75
details report 133
editing 75
exclude unnecessary 144
importing 29
lock scores 73
missing report of 125
modifying 71
move 76
notes 74
other ways of creating 70
other ways to edit 75
other ways to sort 79
rename 71
replace 76
scale factor 78, 99
scramble sort 79
selecting for a report 118
sorting 78
sorting manually 79
statistics 74
use shortened names 51
viewing 71

Task Comparison graph 136
Task Correlation graph 138
Task Details report 133
Task type sets. See Sets.
Task types. See Types.
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Task view 9, 52
Tasks

importing 29
Technical Support 13
Tilde (~) 66
Toolbar 2
Total Points spreadsheet 5
Training 13
TSS 31, 114, 144
TSS/TESS 30
Type 3

add to set 39
create new 38
delete 39
rename 39

Type view 9, 52

U
Update mode 110
Upgrade note 2

V
View drop-down list 9
Viewer 7

closing 9
open more than one 8
opening 9
steps to working in 8

Visual cues 79, 99, 101

W
Weighted spreadsheet 5
Windows

and Macintosh compatibility 27, 40
context menus 9
creating installation disks 18
customize columns 54
file extension 153
file name 27
installation

on server 18
stand-alone 18
to client from server 19
using disks 18

installing from a network server 19
mapped drives 18, 151
previewing graphs 141

previewing reports 140
report differences 140
requirements 16
scanning 16, 85
system requirements 16
three ways to install 17
using Macintosh files 12

X
xrefpict.txt 113
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